
Click here for general information on using Hoyle Classic Board Games.

Click a game (below) to learn how it is played.



General information about Hoyle Classic Board Games
The topics in this section provide information on playing Hoyle Classic Board Games and explain the play options 
available to you.

Click the following topics for more information on using Hoyle Classic Board Games.
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              The games  
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Backgammon
The topics in this section provide information on how to play the game of Backgammon.

Playing Backgammon
How to play Backgammon
Getting started
How the game of Backgammon evolved
Setting game rules and options
Viewing the current standings 
Viewing player statistics 

Backgammon menu commands, dialog boxes, and screen elements
File menu
Game menu
Actions menu
Options menu
Help menu

Using Hoyle Classic Board Games
General information about Hoyle Classic Board Games 
Descriptions of Hoyle board game menu commands, dialog boxes and screen elements
Shortcut keys



Current Standings
Statistics
Battling Ships 
Checkers 
Chess 
Chinese Checkers 
Dominoes 
Pachisi 
Snakes & Ladders 
Yacht 
Zen Bones 



Roll Dice
Double
Resign 
Undo



Controls
Players
Backgrounds
Game Setup 





Battling Ships
The topics in this section provide information on how to play the game of Battling Ships.

Playing Battling Ships
How to play Battling Ships
Getting started
How the game of Battling Ships evolved
Setting game rules and options
Viewing the current standings 
Viewing player statistics 

Battling Ships menu commands, dialog boxes, and screen elements
File menu
Game menu
Actions menu
Options menu
Help menu
Strategic Command Center

Using Hoyle Classic Board Games
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Descriptions of Hoyle board game menu commands, dialog boxes and screen elements
Shortcut keys
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Fire
Clear All



Controls
Players
Backgrounds
Game Setup





Checkers
The topics in this section provide information on how to play the game of Checkers.

Playing Checkers
How to play Checkers
Getting started
How the game of Checkers evolved
Setting game rules and options
Viewing the current standings
Viewing player statistics

Checkers menu commands, dialog boxes, and screen elements
File menu
Game menu
Actions menu
Options menu
Help menu
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Current Standings
Statistics
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Dominoes 
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Request Draw
Resign



Controls
Players
Backgrounds
Game Setup





Chess
The topics in this section provide information on how to play the game of Chess.

Playing Chess
How to play Chess
Getting started
How the game of Chess evolved
Setting game rules and options
Viewing the current standings
Viewing player statistics

Chess menu commands, dialog boxes, and screen elements
File menu
Game menu
Actions menu
Options menu
Help menu
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Current Standings
Statistics
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Checkers 
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Undo
Request Draw
Resign



Controls
Players
Backgrounds
Game Setup
Show 2D Board 





Chinese Checkers
The topics in this section provide information on how to play the game of Chinese Checkers.

Playing Chinese Checkers
How to play Chinese Checkers
Getting started
How the game of Chinese Checkers evolved
Setting game rules and options
Viewing the current standings
Viewing player statistics

Chinese Checkers menu commands, dialog boxes, and screen elements
File menu
Game menu
Actions menu
Options menu
Help menu

Using Hoyle Classic Board Games
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Current Standings
Statistics
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No Actions Available 



Controls
Players
Backgrounds
Game Setup





Dominoes
The topics in this section provide information on how to play the game of Dominoes.

Playing Dominoes
How to play Dominoes
Getting started
How the game of Dominoes evolved
Setting game rules and options
Viewing the current standings
Viewing player statistics

Dominoes menu commands, dialog boxes, and screen elements
File menu
Game menu
Actions menu
Options menu
Help menu
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Current Standings
Statistics
Backgammon 
Battling Ships 
Checkers 
Chess 
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Yacht 
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Pass



Controls
Players
Backgrounds
Game Setup





Pachisi
The topics in this section provide information on how to play the game of Pachisi.

Playing Pachisi
How to play Pachisi
Getting started
How the game of Pachisi evolved
Setting game rules and options
Viewing the current standings
Viewing player statistics

Pachisi menu commands, dialog boxes, and screen elements
File menu
Game menu
Actions menu
Options menu
Help menu
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Current Standings
Statistics
Backgammon 
Battling Ships 
Checkers 
Chess 
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Zen Bones 



Pass     
Roll Dice



Controls
Players
Backgrounds
Game Setup





Snakes & Ladders
The topics in this section provide information on how to play the game of Snakes & Ladders.

Playing Snakes & Ladders
How to play Snakes & Ladders
Getting started
How the game of Snakes & Ladders evolved
Setting game rules and options
Viewing the current standings
Viewing player statistics

Snakes & Ladders menu commands, dialog boxes, and screen elements
File menu
Game menu
Actions menu
Options menu
Help menu
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Current Standings
Statistics
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Draw Ball



Controls
Players
Backgrounds
Game Setup





Yacht
The topics in this section provide information on how to play the game of Yacht.

Playing Yacht
How to play Yacht
Getting started
How the game of Yacht evolved
Setting game rules and options
Viewing the current standings
Viewing player statistics

Yacht menu commands, dialog boxes, and screen elements
File menu
Game menu
Actions menu
Options menu
Help menu
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Current Standings
Statistics
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Checkers 
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Pachisi 
Snakes & Ladders 
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Roll Dice
Keep Dice
Release Dice



Controls
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Backgrounds
Game Setup





Zen Bones
The topics in this section provide information on how to play the game of Zen Bones.

Playing Zen Bones
How to play Zen Bones
Getting started
How the game of Zen Bones evolved
Setting game rules and options
Viewing the current standings
Viewing player statistics

Zen Bones menu commands, dialog boxes, and screen elements
File menu
Game menu
Actions menu
Options menu
Help menu
Layout Editor
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Current Standings
Statistics
Backgammon 
Battling Ships 
Checkers 
Chess 
Chinese Checkers 
Dominoes 
Pachisi 
Snakes & Ladders 
Yacht 



Find Match
Remove Pair
Undo



Controls
Players
Backgrounds
Game Setup





This file includes all general step topics.

General Board Games How Tos follow here
fix all of these following topics



Signing in
Hoyle Classic Board Games

When you first open Hoyle Classic Board Games, you must sign in. Only one person can be "signed-in" at one 
time. When you start a new game, the human "signed-in" player typically is positioned in the first seat, with 
computer character players (if any) positioned in the other seats. A human player's statistics, standings, and 
scores are saved with each signed-in player name.
All human players' statistics from the previous games carry over to each new game. All play options and control 
settings also persist between games.

To sign in
1 Choose the silhouette for the player (male human, female human, extraterrestrial, bug, monster, rabbit, 

chicken, jester, or dinosaur). To change your player's silhouette, move the scroll bar under the player view area 
at the right of the Sign In dialog box.

2 To add a new player, type the name in the Player Name dialog box, then click OK. You may need to press the 
Backspace key several times to clear the previous name text.
To sign in as an different player, click a name in the player list.
To delete a player, click a name in the player list, then click Delete.

3 Click New or OK to accept the player setting.

See also
Changing the current human player
Changing a character player
Choosing a game
Choosing a game in the log cabin
Choosing a game in the spaceship
Leaving a game
Opening a previously saved game
Quitting a game session
Reverting to a saved game
Saving the current game
Starting a network game



Choosing a game
Hoyle Classic Board Games

You can very easily jump from one game to any other game in Hoyle Classic Board Games.

To choose a game
On the main Board games screen, click the game you want to go to.
Or
On the main Board games screen, click the log cabin or the spaceship. You can then choose games by 

clicking them in the log cabin's rooms, or on the spaceship's control panel.
Or
In one of the game screens, choose the game you want to go to from the Game menu.
Or
From any screen, choose Open Game from the Game menu and select the game from the list of saved 

games.

See also
Choosing a game in the log cabin
Choosing a game in the spaceship
Leaving a game
Opening a previously saved game
Quitting a game session
Reverting to a saved game
Saving the current game
Starting a network game



Choosing a game in the log cabin
Hoyle Classic Board Games

The games are located in different areas of the log cabin. To see the name of a game, pass your cursor over the 
game. A message box appears with the game name. To join a game, click on it.
When you choose the game, the cabin room becomes the background. You can change the look of the 
background further by choosing Backgrounds from the Options menu.
You can find Chess, Checkers, and Chinese Checkers in the main room. The other games are located in the 
bookcase.
Click on the left side of the room to find the bookcase. Click the bookcase to see its games up close. Click the right
side of the bookcase room to return to the main room.
To exit, click the right side of the main room.
Tip In the log cabin, you can change the seasons to get a different view from the window (choose Seasons from 
the Options menu).

See also
Choosing a game
Choosing a game in the spaceship
Leaving a game
Opening a previously saved game
Quitting a game session
Reverting to a saved game
Saving the current game
Starting a network game



Choosing a game in the spaceship
Hoyle Classic Board Games

To join a game, click the blue or tan buttons on the main control panel in the spaceship. A hologram appears to 
indicate the game. To join the game that is appearing as a hologram, click Engage.
When you choose the game, the spaceship room becomes the background. You can change the look of the 
background further by choosing Backgrounds from the Options menu.
Click to the right of the control panel to see the game play area. In the game play area, click the left side of the 
screen to return to the control panel.
To exit, click to the left of the control panel to find the exit door (click Out to leave the spaceship). In the game play 
area, click the right side of the room to find the exit door.

See also
Choosing a game
Choosing a game in the log cabin
Leaving a game
Opening a previously saved game
Quitting a game session
Reverting to a saved game
Saving the current game
Starting a network game



Leaving a game
Hoyle Classic Board Games

You can leave a game and go back to the main Board game screen, or go straight to another Board game.

To leave a game
Choose Leave <Game> from the File menu. You are returned to the main Board game screen.
Or
Choose the game you want to go to from the Game menu.

See also
Choosing a game
Opening a previously saved game
Quitting a game session
Reverting to a saved game
Saving the current game
Starting a network game



Saving the current game
Hoyle Classic Board Games

If you are enjoying a particular game, you can save the game before leaving it. The next time you open Hoyle 
Classic Board Games and sign-in as the same player, then open the game, the same players and game setup will 
be waiting for you.
If you want to save your statistics from the board game session, but not the current game settings, choose Exit.

To save a game
Choose Save Game or Save Game As from the File menu.

See also
Choosing a game
Leaving a game
Opening a previously saved game
Reverting to a saved game
Starting a network game



Opening a previously saved game
Hoyle Classic Board Games

If you saved a game in a previous gaming session, you can open it by choosing Open Game from the File menu. 
The game opens with the same players and game setup.

See also
Choosing a game
Leaving a game
Reverting to a saved game
Saving the current game
Starting a network game



Reverting to a saved game
Hoyle Classic Board Games

If you reopen a game that you saved in a previous gaming session, and decide after playing for a while that you 
want to start over at the point where you originally saved the game, you can return to that point in play by choosing
Revert To Saved Game from the File menu.

See also
Choosing a game
Leaving a game
Opening a previously saved game
Saving the current game
Starting a network game



Quitting a game session
Hoyle Classic Board Games

When you quit a gaming session, your scores and statistics are saved and are used the next time you open Hoyle 
Classic Board Games and start a new game.
When you quit a game, all play options and control settings are saved, but player assignments are not. You must 
sign in every time you start a new session.
If you want to save the current table settings (includes all character seat assignments) along with your statistics for
the current game session, choose Save Game or Save Game As instead of Exit.

To quit a game
Choose Exit from the File menu.

To save the current game
Choose Save Game or Save Game As from the File menu.

See also
Saving the current game



Changing the current player
Hoyle Classic Board Games

When you start a new game, the human "signed-in" player typically is positioned in the first seat, with computer 
character players (if any) positioned in the other seats.
You can change the player you signed in as to a different player at any time during a gaming session. You change 
the current player setting by choosing the New Player dialog box.
Note You can only change the current human player using the New Player dialog box when you are in the main 
Hoyle Classic Board Games screen, not when you are in a game. You change the current player during a game, 
using the Players dialog box.
To change the current human player or character players within a game, see Changing a character player.

To change the "signed-in" player (before or after playing a game)
1 In the main Hoyle Classic Board Games screen, choose New Player from the File menu. The New Player 

dialog box opens. (You might need to choose Leave <Game> to get back to the main screen.)
2 Choose the silhouette for the player (male human, female human, extraterrestrial, bug, monster, rabbit, 

chicken, jester, or dinosaur). To change your player's silhouette, move the scroll bar under the player view area 
at the right of the Sign In dialog box.

3 To add a new player, type the name in the Player Name dialog box, then click OK. You may need to press the 
Backspace key several times to clear the previous name text.
To sign in as a different player, click a name in the player list.
To delete a player, click a name in the player list, then click Delete.

4 Click New or OK to accept the player setting.

To change the "signed-in" player during a game
1 Click the current "signed-in" player on the game screen.
2 In the Players dialog box, click the name of a different human player.
3 Click OK. This player becomes the new default player for subsequent games.

See also
Adding or removing players
Changing a character player
Setting player attitude



Changing a character player
Hoyle Classic Board Games

You have the option of changing the computer character players in a game using the Players dialog box.
You can assign the same character player to more than one seat (and achieve a clone effect!). You can assign 
more than one human player to most games, but not the same player to multiple seats.
Note You cannot assign more then one human player in Dominoes.

To change a character player
1 At the game table, click (left mouse button) on the player you want to change or reassign. The Players dialog 

box opens.
2 Click the name of player you want to place in that seat (unassigned human player, or character).

To add a new human player to the list, click New. Type the player name, choose a player silhouette, then click 
New.

3 Click OK.

See also
Adding or removing players
Changing the current human player
Setting player attitude



Changing a player's seat
Hoyle Classic Board Games

When you start a new game, the human "signed-in" player typically is positioned in the first seat, with computer 
character players (if any) positioned in the other seats.
You change human and character players' seats in a game using the Players dialog box.

To change a player's seat
1 At the game table, click (left mouse button) on the player at the seat location where you want to place the 

player. The Players dialog box opens.
2 Click the name of player you want to place in that seat (unassigned human player, or character).

If you choose the name of the human player that is already in the game, that player swaps seats with the 
character player you clicked to show the Players dialog box.
To add a new human player to the list, click New. Type the player name, choose a player silhouette, then click 
New.

3 Click OK. The player you choose appears in the new seat. You can assign the same player to multiple seats.

Tip To change the human player that is currently signed-in during a game: Click that player on the game screen, 
click the name of a different human player, then click OK. This player becomes the new default player for 
subsequent games.

See also
Adding or removing players
Changing a character player
Changing the current player
Setting player attitude



Adding or removing players
Hoyle Classic Board Games

You add or remove the number of players in a game using the Game Setup dialog box. The number of players that
are allowed in a game depend on each game's setup options.
You cannot remove a player in the middle of a game; you can only remove players in between games (just before 
the next game begins).
You add or remove human players to or from the player list using the New Player dialog box.

To add or remove players the number of players in a game
1 In any game screen (not the main screen), choose Game Setup from the Options menu. The Options dialog 

box opens on that game's Setup tab.
2 If the game has different options for the number of players allowed, click the number of players you wish to 

have play in the game.
3 Click OK. The appropriate number of players are automatically added or removed from the game.

To add a human player to the player list
1 In the main Hoyle Classic Board Games screen, choose New Player from the File menu. The New Player 

dialog box opens. (You might need to choose Leave <Game> to get back to the main screen.)
2 Choose the silhouette for the player (male human, female human, extraterrestrial, bug, monster, rabbit, 

chicken, jester, or dinosaur). To change your player's silhouette, move the scroll bar under the player view area 
at the right of the Sign In dialog box.

3 Type the new player name in the Player Name dialog box, then click OK. You may need to press the 
Backspace key several times to clear the previous name text.

4 Click New to accept the player setting.

To remove a human player from the player list
1 In the main Hoyle Classic Board Games screen, choose New Player from the File menu. The New Player 

dialog box opens. (You might need to choose Leave <Game> to get back to the main screen.)
2 In the player list, click the name of the player to be removed.
3 Click Delete.

See also
Changing a character player
Changing the current human player
Setting player attitude



Player profiles
Hoyle Classic Board Games

When you play the different board games, you have a choice of many interesting characters to choose as 
opponents. Here are their personality traits:
Bart

Bart is a country gentleman who earned his gaming experience aboard the riverboats near his home town. While his 
cordial demeanor might put you at ease, don't let down your guard...he'll make his move faster than you can say 
"sissified pretty boy."
Elayne

Elayne is a native Manhattanite who doesn't see why she should ever leave. This fast-track advertising exec unwinds 
from a hectic day on Madison Avenue with some of the most popular games of all time.
Gax

Gax can rearrange his molecules to look like anyone he wants. What started as a party trick has led to a lucrative 
career. He hopes to earn enough money to eventually rebuild his ship and return to his home planet.

Harley

Harley is a talking bear who likes food and rolling in the grass. He doesn't like forest fires, tourists, and hikers who 
think they can run away.
Jasper



Since Jasper left Jamaica years ago, he has traveled the world as a jazz bass player. All that time on the road has 
made him a world class gamer. Jasper points out, "A good game is like a song that starts slowly and builds to a 
strategic crescendo."
Langley

Langley is a lawyer with an Ivy League background, who is taking a little break from his practice to learn how to relax 
through gaming. Though he appears to be a cool cucumber on the outside, inside he's chomping at the bit to add 
another win to his newfound gaming hobby.

Maurice

Maurice, a fur trapper from 1837, was abducted by aliens and traveled hundreds of light-years to a distant civilization.
He was returned to Earth 150 years later, shaken by the ordeal, and now consults his beaver puppet for strategic 
advice.
Miranda

Miranda has led an exciting life as a nature photographer in her native Australia. She likes to unwind with the games 
that are considered classic in her country as well as in ours.
Mrs. O'Shea

A consummate gamer, Mrs. O'Shea enjoys casino games most of all, yet she's no stranger to non-wagering games. 
Be careful, she'll offer you home-made cookies with a smile while she beats you like a dusty rug.



Primus

Primus is an experiment in auto-psychotherapy. He was programmed to critique your response ink blots and help you
cope with stress. Tell him about your thoughts, even your mother; just don't tell him where you placed your ships.
Robin

Robin chucked her big-city brokerage job for the National Forest Service. Now she spends her days hiking forest 
trails and communing with nature. But don't think that being out in the woods all day means she's forgotten anything 
about gaming.
Nitro and Terra

Nitro and Terra have been in space way too long. You know how married couples finish each other's sentences? This 
couple finishes each other's games...so they rarely play each other. Against you, they could be a formidable team.

See also
Adding or removing players
Changing a character player
Setting player attitude



Setting player attitude
Hoyle Classic Board Games

When you play any game with animated character players, you have the option of setting their attitude, which 
includes how talkative and animated they are during the game. The attitude is set for all animated characters in 
the game. You cannot set an individual character's attitude.
You set player attitude using the Controls tab in the Options dialog box.

To set player attitude
1 Choose Controls from the Options menu.
2 To hear players talk, check Character Speech. To prevent players from talking at all, uncheck this option.
3 Move the attitude slider bar to the right (Talkative = more attitude) or the left (Serious = less attitude) to adjust 

the players' attitudes.
4 Click OK to accept the new setting.

See also
Adding or removing players
Changing a character player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game speed
Setting game rules and options
Viewing the current standings
Viewing player statistics



Setting game speed
Hoyle Classic Board Games

You set the speed of animations and play for all the board games using the Controls tab in the Options dialog box.

To set game speed
1 Choose Controls from the Options menu.
2 Move the Speed slider bar to the left (slower) or right (faster) to adjust the speed.
3 Click OK to accept the new setting.

See also
Adding or removing players
Changing a character player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting player attitude
Viewing the current standings
Viewing player statistics



Controlling sound effects, animations, or background music
Hoyle Classic Board Games

You can control whether you hear sound effects or background music during game play, or whether game 
animations run, by using the Controls tab in the Options dialog box. The sound effects include sounds such as 
rolling dice. Character talking is not included with sound effects (see Setting player attitude).

To control sound effects, animations, or background music during games
1 Choose Controls from the Options menu.
2 For Sound Effects: Check Sound Effects to turn game sounds on. Uncheck Sound Effects to turn sounds off for 

all games.
For Animations: Check Animations to turn all animations on. Uncheck Animations to stop extra animations from 
running during games.
For Background Music: Check Background Music to turn all background music on. Uncheck Background Music 
to stop background music from playing during games. To select specific background music, click on the music 
in the list.

3 Click OK to accept the settings.

See also
Adding or removing players
Changing a character player
Changing the look of the background
Setting game speed
Setting game rules and options
Setting player attitude
Viewing the current standings
Viewing player statistics



Setting game rules and options
Hoyle Classic Board Games

Each Hoyle board game has different game setup options, such as setting the number of players for the game and
the rule variations for the game. You control each game's setup using the Game Setup tab in the Options dialog 
box.

To set game rules and options
1 In the game you want to setup, choose Game Setup from the Options menu.
2 Make the changes you want to settings.
3 Click OK to accept the setup.

See also
Adding or removing players
Changing a character player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game speed
Setting player attitude
Viewing the current standings
Viewing player statistics



Viewing player statistics
Hoyle Classic Board Games

You display player statistics during play by choosing Statistics from the Game menu. The Statistics dialog box 
includes information on wins, losses, points, scores, and standings as they apply to each game. Click the player 
name, then click a game's tab to view statistics for that game.
Backgammon Statistics 
Battling Ships Statistics 
Checkers Statistics 
Chess Statistics 
Chinese Checkers Statistics 
Dominoes Statistics 
Pachisi Statistics 
Snakes & Ladders Statistics 
Yacht Statistics 
Zen Bones Statistics 

See also
Viewing the current standings



Viewing the current standings
Hoyle Classic Board Games

You display the standings for the current game during play by choosing Current Standings from the Game menu. 
The Current Standings dialog box includes information on points, scores, and standings as they apply to each 
game.
Backgammon Current Standings 
Battling Ships Current Standings 
Checkers Current Standings 
Chess Current Standings 
Chinese Checkers Current Standings 
Dominoes Current Standings 
Pachisi Current Standings 
Snakes & Ladders Current Standings
Yacht Current Standings 
Zen Bones Current Standings 

See also
Viewing player statistics



Changing the look of background
Hoyle Classic Board Games

Hoyle Classic Board Games includes a variety of different backgrounds for your games.
The background you choose is used for all the games. You can't set a different background for each separate 
game, but you can change the background shared by all the games at any time during any game.

To change the background
1 Choose Backgrounds from the Options menu.
2 Click a background style in the list. A preview of the background appears.
3 Click Apply to see the background in the current game. Click OK to accept the background change.

See also
Adding or removing players
Changing a character player
Controlling sound effects, animations, or background music
Setting game speed
Setting game rules and options
Setting player attitude
Viewing the current standings
Viewing player statistics



Starting a network game
Hoyle Classic Board Games

By choosing Start Network Game from the Network menu, you start a network version of Hoyle Classic Board 
Games. You can play Backgammon, Battling Ships, Checkers, Chess, Chinese Checkers, and Yacht on-line over 
the Internet, against opponents from all over the world.

Logging On (requirements for network play)
To play a network game, you must first connect to the Internet via your Internet Service Provider (ISP).    Start your
Internet software and leave it running, then return to Hoyle Classic Board Games and choose Start Network Game
from the Network menu. Alternatively, some Internet connection methods (like Windows 95 Dial Up Networking) 
will be automatically initiated by Windows 95 when you choose Start Network Game.
Note You must have at least a 14.4 Kbps modem, although a 28.8 Kbps of faster modem is strongly 
recommended.
Your Internet access must be a SLIP/PPP connection that supports WinSock32. Contact your Internet Service 
Provider if you are unsure whether they provide this type of access, or if you have questions regarding how to 
connect to the Internet.
Note If you use America Online to connect to the Internet, you must use the 32-bit version of AOL 3.0 made 
specifically for Windows 95. 

To start a network game
When you choose Start Network Game from the Network menu (and your Internet connection is open) the game 
then connects you to the Sierra Internet Gaming System (SIGS) server. You will need to provide a user name and 
a password to gain entry to the SIGS gaming area.
If you are a first time user, click New Member after providing your user name, a temporary password, and your e-
mail address. SIGS creates your membership with this information, then e-mails a confirmation of your password. 
If you have logged onto the server before, click Enter after providing your user name and password.

To end a network game
Choose Leave Network from the Game menu.

Using the Sierra Internet Gaming System (SIGS)
The Sierra Internet Gaming System provides help on how to navigate around the gaming rooms and how to create
or join a game. For details, click Help in the SIGS main gaming area screen.

Hoyle Class Board Games on the Internet
For two-player games (Backgammon, Battling Ships, Checkers, and Chess), the game starts automatically as 
soon as another player joins your game. For games that allow more than two players (Yacht allows up to four 
players; Chinese Checkers allows up to six players) you have the option of starting the game as soon as you have
two players, but you can wait for more players to join before starting.
When a game starts, all players screens change to the screen for that game. The game creator's Game Setup 
network-supported settings are used for all players that join his or her game. Other settings, such as character 
speech, sound effects, animations, music, and background images vary according to each individuals game 
settings (see Controls).
Some of the games allow the player who created the game to choose additional settings for the game.

Checkers. Game creator can choose his or her color.
Chess. Game creator can choose his or her color.
Chinese Checkers. Game creator can choose to allow computer characters to play and decide where 

players are positioned around the board.
Yacht. Game creator can choose to allow computer characters to play.

Note Be aware that character speech, sound effects, animations, and music can cause your game to move more 
slowly than your opponent's, which in turn slows the overall game progress. You may ask all players to turn their 
Animations option off to speed up play (see Controls).
Statistics are not tracked for network games. You cannot save or load games during network play.
With network Chess, the player who creates the network game has the option of saving and opening Chess 
games while playing over the network. Just as in a non-network play, the Save, Save As, and Open commands in 
the File menu are used for this purpose. Before you open a saved game during network play, you might want to 
chat with your opponent to confirm that he or she is ready for you to do this.



Chatting with players
You can chat with other players while you are playing network games using the SIGS Chat Log window and/or 
Chat balloons.
To chat with other players during a game using the Chat Log window:

Press Enter to start a new chat line. Type your message, then press Enter again to display your message to 
the other players. Press Esc to cancel the message.

To chat with other players during a game using the Chat balloon:
Click the balloon that appears next to your player icon, then press Enter to start a new chat line. Type your 
message. Press Enter again to display your message to other players. Click Esc to cancel the message.

If you experience persistent difficulties in establishing a connection with the SIGS server, see Network game 
troubleshooting.

See also
Network game troubleshooting



Network game troubleshooting
Hoyle Classic Board Games

When you attempt to start a network board game, you may experience difficulties in establishing a connection with
the SIGS server. Before you contact SIGS technical support, please check the following:

Are you connected to the Internet? You must create an open Internet connection to start a network game.
Are you running Windows 95? Hoyle Internet board games run only in Windows 95.

If you are running Windows 95 and you are connected to the Internet, you may want to attempt to log in to the 
SIGS server several times. The Sierra Internet Gaming System server is sometimes unavailable, but only for short 
periods of time.
If you are running Windows 95 and you are connected to the Internet, but you still cannot connect to the SIGS 
server, you may need to contact your Internet service provider and ask the following questions:

Does your Internet service provider support a 32-bit WinSock DLL (WSOCK32.DLL)? The SIGS server
requires a 32-bit WinSock DLL. The WSOCK32.DLL file may exist in your computer's WINDOWS\SYSTEM directory, 
but your Internet service provider may not be accessing this DLL.

Is your Internet connection a true PPP connection?
Is a unique IP address assigned to your Internet connection every time you log in?

The SIGS server requires a true PPP connection or a unique IP address every time you log in.
Is the Internet connection you are using located behind a "fire wall"?

Some Internet connections, such as those in an office workplace, are located behind a "fire wall" for protection. 
The SIGS server does not support "fire wall" protected Internet connections.

If you have addressed all of the questions in this help topic and you continue to experience difficulties in 
establishing a connection with the SIGS server, please contact the following:
SIGS email technical support
For email technical support, contact sigs.help@sierra.com. Enter the name of your Sierra game in the subject line
(for example, Hoyle Classic Board Games Checkers).
SIGS technical support on the Web
For the latest technical support information on SIGS Internet issues and version updates, use your web browser to
visit http://www.sierra.com/sigs.





This file includes all general menu command/interface topics and all general step topics.

Main screen menus

Click a game icon to go to it - Finding a game step topic
Click the log cabin to? Click the rocket to?

File
New Player
Open Game
Save Game
Save Game As
Revert To Saved Game
Exit

Game
Statistics
Backgammon
Battling Ships
Checkers
Chess
Chinese Checkers
Dominoes
Pachisi
Snakes & Ladders
Yacht
Zen Bones

Options
Controls...

Network - what's supported?
Start Network Game
Leave Network Game (End? Exit?))

Help - one screen popup for this - use Casino as example



Descriptions of menu commands, dialog boxes, and screen elements
Hoyle Classic Board Games

Click a menu name, then click a command to see its description.



File menu
New Player     
Leave <Game>
New Game     
Open Game     
Save Game     
Save Game As     
Revert To Saved Game     
Exit 



Game menu
Main Screen
Statistics
Backgammon 
Battling Ships 
Checkers 
Chess 
Chinese Checkers 
Dominoes 
Pachisi 
Snakes & Ladders 
Yacht 
Zen Bones 

Network Play Main Screen
Leave Network 
Exit 



Options menu
Main screen
Controls 
Log Cabin Main screen
Controls 
Seasons 
Game screens
Controls 
Players
Backgrounds
Game Setup



Network menu
Start Network Game     



Help menu
The Help menu provides different commands for finding the information you need in the Hoyle Classic Board Games 
Help file. Help information for the game you are currently playing is available as this command in the Help menu.

About X. Help information for the game you are currently playing is available as this command in the Help 
menu.

Contents. Takes you to the main table of contents in the Help file.
 Index. Displays the topic index of the Help file.

Help on Help. Opens the Windows Help file with general information on using a Windows Help file.
About Hoyle Classic Board Games. Displays information about this version of the game.



Shortcut keys
Hoyle Classic Board Games

The following shortcut keys are available to you during game play:

Backgammon
Actions Shortcut key
Double D
Roll Dice Spacebar
Resign S
Undo Ctrl+Z

Battling Ships
Actions Shortcut key
Fire (Missiles) Spacebar
Clear All (Targets) Backspace

Checkers
Actions Shortcut key
Resign R
Request Draw D
Pass Enter (This option is only available when the Must Jumped option is unchecked.)

Chess
Actions Shortcut key
Resign R
Request Draw D
Undo Ctrl+Z

Chinese Checkers
No actions are necessary for Chinese Checkers.

Dominoes
Actions Shortcut key
Pass Enter

Pachisi
Actions Shortcut key
Pass Enter
Roll Dice Spacebar

Snakes & Ladders
Actions Shortcut key



Draw Ball Spacebar

Yacht
Actions Shortcut key
Roll Dice Spacebar
Keep Dice <Type each die number>
Release Dice Backspace

Zen Bones
Actions Shortcut key
Find Match M
Remove Pair Enter
Undo Ctrl+Z



Descriptions of all UI follow here

All 



Sign In
Hoyle Classic Board Games

Sets the player you want to play as for the current session. When you start a new game, the human "signed-in" 
player typically is positioned in the first seat, with computer character players (if any) positioned in the other seats.
You can either add a new player, or select an existing player name from the list. Click OK to accept the default 
player settings and begin the game.
To change your player's silhouette
Move the scroll bar under the player view area at the right of the Sign In dialog box.

To choose a different player (than the default)
In the player list, click the name of an existing player, then click OK.

To add a new player to the list
In the Player Name box, delete the current name by pressing Backspace on the keyboard, then type a name for 
the player. Click New to add the player to the list.

To delete a player from the list
In the player list, click the name of the player to be removed, then click Delete.

All statistics, standings, and scores are saved for each human player, and persist between game sessions. For 
example, if you play one game session as Player 1, and play another game session as Player 2, two separate sets
of statistics, standings, and scores are stored, one for each player.
By default, the name and options in this dialog box are set to the last player to sign in.

Options Description
Player Silhouette Sets the silhouette for your player at the game table. Move the scroll bar to 

choose from: male human, female human, extraterrestrial, bug, monster, rabbit, 
chicken, jester, or dinosaur.

Names list Scroll through the list of existing players to choose a player. The last sign in 
name is the default setting.
To add a new player to the list, in the Player Name box, delete the current name 
by pressing Backspace on the keyboard, then type a name for the player. Click 
New to add the player to the list.
To choose a different existing player, click the player name in the list, then click 
OK.

New Creates a new player, adds that player to the Names list, and begins the gaming 
session.

Delete Deletes the selected player from the player list.
OK Accepts the player settings and begins the gaming session.

See also
Changing the current human player
Changing a character player
Choosing a game
Choosing a game in the log cabin
Choosing a game in the spaceship
Leaving a game
Opening a previously saved game
Quitting a game session
Reverting to a saved game
Saving the current game
Starting a network game



Leave <Game>
File menu

Ends the current game and returns you to the main Hoyle Classic Board Games screen. This menu command 
changes depending on which game you are currently playing.

See also
Choosing a game
Choosing a game in the log cabin
Choosing a game in the spaceship
Leaving a game
Opening a previously saved game
Quitting a game session
Reverting to a saved game
Saving the current game
Starting a network game



New Player
File menu

Opens the Sign In dialog box, which you can use to create a new player or choose a different default player for the
current session. Add a new player by typing the name in the text box, or select an existing player by clicking the 
name in the player list. Click New or OK to accept your player settings and begin the game.
Note You can also add a new player using the Players tab.
All statistics, standings, and scores are saved for each human player, and persist between game sessions. For 
example, if you play one game session as Player 1, and play another game session as Player 2, two separate sets
of statistics, standings, and scores are stored, one for each player.
By default, the name and options in this dialog box are set to the last player to sign in.
Tip To change the human player that is currently signed-in during a game: Click that player's icon on the game 
screen, click the name of a different human player in the player list, then click OK. This player becomes the new 
default player for subsequent games.

Options Description
Player Silhouette Sets the silhouette for your player at the game table. Move the scroll bar to 

choose from: male human, female human, extraterrestrial, bug, monster, rabbit, 
chicken, jester, or dinosaur.

Names list Scroll through the list of existing players to choose a player. The last sign in 
name is the default setting.
To add a new player to the list, in the Player Name box, delete the current name 
by pressing Backspace on the keyboard, then type a name for the player. Click 
New to add the player to the list.
To choose a different existing player, click the player name in the list, then click 
OK.
To delete a player from the list, click the player name in the list, then click Delete.

New Creates a new player, adds that player to the Names list, and begins the gaming 
session.

Delete Deletes the selected player from the player list.
OK Accepts the player settings and begins the gaming session.

See also
Changing the current human player
Changing a character player
Choosing a game
Choosing a game in the log cabin
Choosing a game in the spaceship
Leaving a game
Opening a previously saved game
Quitting a game session
Reverting to a saved game
Saving the current game
Starting a network game



New Game
File menu

Starts a new game of the Hoyle board game you are currently playing. To choose a different type of board game, 
choose Open Game from the File menu, or choose the game's name from the Game menu.

See also
Changing the current human player
Changing a character player
Choosing a game
Choosing a game in the log cabin
Choosing a game in the spaceship
Leaving a game
Opening a previously saved game
Quitting a game session
Reverting to a saved game
Saving the current game
Starting a network game



Open Game
File menu

Opens a Hoyle board game that you have previously saved. To start a new game of the same type of Hoyle board 
game you are currently playing, choose New Game from the File menu.

See also
Choosing a game
Choosing a game in the log cabin
Choosing a game in the spaceship
Leaving a game
Opening a previously saved game
Quitting a game session
Reverting to a saved game
Saving the current game
Starting a network game



Save Game
File menu

Saves the current game along with its current setup, players, statistics, and standings. You can then play the game
at another time by choosing Open from the File menu and selecting that game.

See also
Choosing a game
Choosing a game in the log cabin
Choosing a game in the spaceship
Leaving a game
Opening a previously saved game
Quitting a game session
Reverting to a saved game
Saving the current game
Starting a network game



Save Game As
File menu

Saves the current game along with its current setup, players, statistics, and standings. You can then play the game
at another time by choosing Open from the File menu and selecting that game.

See also
Choosing a game
Choosing a game in the log cabin
Choosing a game in the spaceship
Leaving a game
Opening a previously saved game
Quitting a game session
Reverting to a saved game
Saving the current game
Starting a network game



Revert To Saved Game
File menu

If you reopen a game that you saved in a previous gaming session, and decide after playing for a while that you 
want to start over at the point where you originally saved the game, you can return to that point in play by choosing
Revert To Saved Game from the File menu.

See also
Choosing a game
Choosing a game in the log cabin
Choosing a game in the spaceship
Leaving a game
Opening a previously saved game
Quitting a game session
Reverting to a saved game
Saving the current game
Starting a network game



Exit
File menu

Closes the Hoyle Classic Board Games application.

See also
Choosing a game
Choosing a game in the log cabin
Choosing a game in the spaceship
Leaving a game
Opening a previously saved game
Quitting a game session
Reverting to a saved game
Saving the current game
Starting a network game



Game menu stuff follows



Statistics
Game menu

Displays the Statistics dialog box with information on wins, losses, points, scores, and standings as they apply for 
each game. Click the player name, then click a game's tab to view statistics for that game.
Backgammon Statistics 
Battling Ships Statistics 
Checkers Statistics 
Chess Statistics 
Chinese Checkers Statistics 
Dominoes Statistics 
Pachisi Statistics 
Snakes & Ladders Statistics 
Yacht Statistics 
Zen Bones Statistics 

See also
Current Standings



Current Standings
Game menu

Displays the Current Standings dialog box with information on wins, losses, scores, or standings for each 
registered player, and for each game.
Backgammon Current Standings 
Battling Ships Current Standings 
Checkers Current Standings 
Chess Current Standings 
Chinese Checkers Current Standings 
Dominoes Current Standings 
Pachisi Current Standings 
Snakes & Ladders Current Standings 
Yacht Current Standings 
Zen Bones Current Standings 

See also
Statistics



Backgammon
Starts a game of Backgammon .



Battling Ships
Game menu

Starts a game of Battling Ships.



Checkers
Game menu

Starts a game of Checkers.



Chess
Game menu

Starts a game of Chess.



Chinese Checkers
Game menu

Starts a game of Chinese Checkers.



Dominoes
Game menu

Starts a game of Dominoes.



Pachisi
Game menu

Starts a game of Pachisi.



Snakes & Ladder
Game menu

Starts a game of Snakes & Ladders.



Yacht
Game menu

Starts a game of Yacht.



Zen Bones
Game menu

Starts a game of Zen Bones.



Backgammon unique menus



Actions menu stuff follows



Actions menu commands
The Actions menu contains the following menu commands for each game:

Backgammon
Roll Dice 
Double 
Undo 
Battling Ships
Fire 
Clear All 
Checkers
Resign 
Request Draw 
Pass 
Chess
Undo 
Resign 
Request Draw 
Chinese Checkers
No actions

Dominoes
Pass 
Pachisi
Pass 
Roll Dice 
Snakes & Ladders
Draw Ball 
Yacht
Roll Dice 
Keep   Dice   
Release   Dice   
Zen Bones
Find Match 
Remove Pair 
Undo 

Roll Dice
Actions menu (Backgammon)

Rolls the dice for first roll and subsequent rolls for moving your pieces.
You can roll the dice during play by:

Clicking the dice cup.
Pressing the Spacebar on the keyboard.
Choosing Roll Dice from the Actions menu.

See also
How to play Backgammon



Double
Actions menu (Backgammon)

If the you have enabled the doubling cube in your game setup (see Game Setup), you have the option of using it 
at appropriate times during play.
You can double during play by:

Clicking the doubling cube on the table.
Pressing the letter D on the keyboard.
Choosing Double from the Actions menu.

See also
How to play Backgammon



Resign
Actions menu (Backgammon)

Resigns your player from the current game. This is counted as a loss.
You can resign during play by:

Pressing the letter S on the keyboard.
Choosing Resign from the Actions menu.

See also
How to play Backgammon



Undo
Actions menu (Backgammon)

Returns your most recent move piece to its previous position.
You can undo the previous move during play by:

Pressing Ctrl+Z on the keyboard.
Choosing Undo from the Actions menu.

See also
How to play Backgammon



Current Standings
Game menu (Backgammon)

Displays the Current Standings dialog box with the number of games played and won, the net points, and the pip 
count (the number of your opponent's stones that do not make it home before you finish).

See also
How to play Backgammon



Statistics
Game menu (Backgammon)

Displays the Statistics dialog box with information on the number of games played and won, the net points, and 
the number of times you gammoned or backgammoned an opponent (see Gammon and Backgammon).

See also
How to play Backgammon



Game Setup
Options menu (Backgammon)

Opens the Game Setup dialog box which you can use to set various options for Backgammon games, including 
rules variations on doubling and first rolls.

Option Description
Doubling Cube Check to enable the doubling cube.
Automatic Doubles None turns off the automatic doubling option. Each of the other number settings 

determines the number of automatic doubles allowed (1, 2, 3, 4, 5, or 6).
Human Plays Brown or White. Choose the color for your pieces.
First Roll These settings determine how you roll on your first turn. On the first roll each player rolls 

one die to decide who moves first.
Must Use First Non-double Roll. Each player must use his or her first roll (non-doubles)
for the first move.

Must Roll Again. Each player must discard the first roll and roll again for the first move.
Can Roll Again. Each player has the option to use the first roll for the first move, or 
discard that roll and roll again.

See also
How to play Backgammon
Getting started
How the game of Backgammon evolved
Adding or removing players
Changing a character player
Changing the current human player
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Battling Ships unique actions and other menus



Fire
Actions menu (Battling Ships)

Starts firing missiles at all targets for that turn.
You can fire missiles at ships during play by:

Clicking the Fire button.
Pressing the Spacebar on the keyboard.
Choosing Fire from the Actions menu.

See also
How to play Battling Ships



Clear All
Actions menu (Battling Ships)

Clears all target settings on the sea grid.
You can clear all grid targets (before firing) during play by:

Clicking the Clear button on the game board.
Pressing Backspace on the keyboard.
Choosing Clear All from the Actions menu.

See also
How to play Battling Ships



Current Standings
Game menu (Battling Ships)

Displays the Current Standings dialog box with information on the number of shots fired, hits, and ships sunk.

See also
How to play Battling Ships



Statistics
Game menu (Battling Ships)

Displays the Statistics dialog box with information on the number of games played, won, and tied.

See also
How to play Battling Ships



Game Setup
Options menu (Battling Ships)

Opens the Game Setup dialog box which you can use to set various options for Battling Ships games, including 
number of missiles and sunk ships.

Option Description
Number of Missiles This setting determines the number of missiles you can launch each turn (1, 2, 3, 4, 5, 6, 

or variable). For Varies With Remaining Ships, the number of shots per turn depends on 
the number of ships you still have in action. The Aircraft Carrier Nimitz supplies 2 shots. All
other ships supply 1 shot each.

Enemy ships Reveal Sunk Location. Reveals the locations of sunken ships on the main grid.

See also
How to play Battling Ships
Getting started
How the game of Battling Ships evolved
Adding or removing players
Changing a character player
Changing the current human player
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Strategic Command Center
Battling Ships

Before you can begin a game of Battling Ships, you must first position your ships on your grid. Click and drag the 
ships to move them. To rotate a ship, select it, then click Rotate 90 degrees.

Click a ship in the illustration below to find out about its vital statistics.

See also
How to play Battling Ships



Nimitz
Ship: USS Nimitz (CVN-68)
Length: 1,092 feet
Top Speed: 30 knots
Main Armament: Eighty aircraft of various types, including bombers, fighters, reconnaissance, and helicopters.
The ships of the nuclear-powered Nimitz class are the largest warships ever to sail the seas. The Nimitz, named for 
the American admiral who took charge of the Pacific fleet after Pearl Harbor, has served from the Mediterranean 
(where its planes downed two Libyan jets in 1981) to the Western Pacific (where the Nimitz provided security for the 
'88 Seoul Olympics).



Iowa
Ship: USS Iowa (BB-61)
Length: 887 feet
Top Speed: 33 knots
Main Armament: Nine guns firing half-ton, 16-inch diameter shells up to 20 miles. Tomahawk cruise missiles 

added in the 1980s.
The Iowa Class battleships, in their combination of speed, armor, and punching power, outshone even the Japanese 
Yamato and the German Bismarck. The Iowa and its three sisters have seen periodic service since the end of WWII. 
The Iowa's most recent mission was escorting tankers through the Persian Gulf during the Iran-Iraq war of 1980-
1988.



Ohio
Ship: USS Ohio (SSBN-726)
Length: 560 feet
Top Speed: 20 knots (surface speed)
Armament: Harpoon and Tomahawk surface-to-air missiles, torpedoes, ballistic missiles.
The Ohio was commissioned in 1981, the first of 18 Ohio-class subs. These boats, with their ability to launch long-
range ballistic missiles armed with nuclear warheads, are the most powerful ships ever to see service in any navy. 
The Ohio can remain at sea for months, if necessary, and still be ready to strike at the enemy.



Fletcher
Ship: USS Fletcher (DD-445)
Length: 376 feet
Top Speed: 38 knots
Main Armament: Five guns firing 5-inch diameter shells, batteries of anti-aircraft cannons and machine guns.
The term "destroyer" was first used in the 1890s to describe the quick little ships that protected battleships against 
enemy torpedo boats. By WWI the "torpedo-boat destroyers" had become warships in their own right. The Fletcher 
served with distinction in the Pacific during WWII, and later supported US ground and air forces in Korea and 
Vietnam.



Seahawk
Ship: USS Seahawk (PT 813)
Length: 199 feet
Top Speed: 45 knots
Main Armament: Computer-guided torpedoes, surface-to-surface and surface-to-air missiles
The original PT (Patrol Torpedo) boats were developed by the United States in WWII as a way of harassing the 
numerically superior Imperial Japanese Navy. These boats were fast, agile, and packed a surprisingly hard wallop. 
The last PT boat was launched in 1951. The Seahawk is a contemporary updating of the original design.



Checkers unique actions and other menus



Resign
Actions menu (Checkers)

Resigns your player from the current game. This is counted as a loss.
You can resign during play by:

Pressing the letter R on the keyboard.
Choosing Resign from the Actions menu.

See also
How to play Checkers



Request Draw
Actions menu (Checkers)

Requests a draw from your opponent.
You can request a draw during play by:

Pressing the letter D on the keyboard.
Choosing Request Draw from the Actions menu.

See also
How to play Checkers



Pass
Actions menu (Checkers)

Passes the turn to the next player when choose not to make a play. You can pass in the middle of a multi-jump 
situation. For example, if you make one jump and have another jump available that you don't want to take, you can
choose to pass instead.
This menu command is available only when the Must Jump option is unchecked in the Checkers Game Setup 
dialog box. If Must Jump is checked, there is no Pass option; you must always make a jump when it is available.
You can pass during play by:

Clicking Pass on the table (if available).
Pressing Enter on the keyboard.
Choosing Pass from the Actions menu.

See also
How to play Checkers



Current Standings
Game menu (Checkers)

Because you can easily determine the number of pieces jumped and crowned, the Current Standings menu 
command is not used for Checkers.

See also
How to play Checkers



Statistics
Game menu (Checkers)

Displays the Statistics dialog box with information on the number of games played, won, lost, and drawn.

See also
How to play Checkers



Game Setup
Options menu (Checkers)

Opens the Game Setup dialog box which you can use to set various options for Checkers games.

Option Description
Must Jump When checked, each player must jump (capture) an opponent's piece or pieces for any 

jump that is possible. If Must Jump is unchecked, you can choose to Pass in a multi-jump 
situation.

Game Variations Standard. Sets the game view to 3-dimensional view with standard round checker 
pieces. You can choose Red or Black for your piece color.
Frogs. Sets the game view to an overhead view with frogs used as checker pieces. 
You can choose Green or Blue for frog color.

See also
How to play Checkers
Getting started
How the game of Checkers evolved
Adding or removing players
Changing a character player
Changing the current human player
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Chess unique actions and other menus



Undo
Actions menu (Chess)

Takes back your most recent move.
You can take back a move during play by:

Pressing Ctrl+Z on the keyboard.
Choosing Undo from the Actions menu.

See also
How to play Chess



Resign
Actions menu (Chess)

Resigns your player from the current game. This is counted as a loss.
You can resign during play by:

Pressing the letter R on the keyboard.
Choosing Resign from the Actions menu.

See also
How to play Chess



Request Draw
Actions menu (Chess)

Requests a draw from your opponent.
You can request a draw during play by:

Pressing the letter D on the keyboard.
Choosing Request Draw from the Actions menu.

See also
How to play Chess



Current Standings
Game menu (Chess)

Displays the Current Standings dialog box with information on the number and rank of pieces captured up to that 
point in the game.

See also
How to play Chess



Statistics
Game menu (Chess)

Displays the Statistics dialog box with information on the number of games played, won, lost, and drawn.

See also
How to play Chess



Game Setup
Options menu (Chess)

Opens the Game Setup dialog box which you can use to set the color for your side (Black or White), show or hide 
the 2-D chess board for play, change the layout of the pieces between turns, and set which side has the next turn.
The Board Layout option allows you to rearrange the layout of your pieces and your opponents pieces before 
continuing play (only when it's your turn). Use this option to rearrange the game pieces and try out different 
strategies and tactics with different layouts.

To move a piece
Drag pieces on the miniature board to reposition them.

To add a new piece to an empty square
You can only add a new piece if it doesn't duplicate a piece that is already on the board. Add a new piece by 
dragging a piece from the right (outside of the board) onto a square. Or, with the piece (outside of the board) 
highlighted, click an empty square to add that piece.

To remove a piece
Right-click a piece or drag it off the board to remove it.

To clear the entire board (except the two Kings), click Clear button.
To return the pieces on the board to match your original game layout, click Reset.

After you set the pieces up, choose Black's Turn or White's Turn to decide who goes first.
You can arrange the board or change the turn only when it is your turn to play. You can also use these options 
during network games, although you should use caution when doing this, since your opponent will not take kindly 
to your rearranging the board without asking first.

See also
How to play Chess
Getting started
How the game of Chess evolved
Adding or removing players
Changing a character player
Changing the current human player
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Show 2D Board
Options menu (Chess)

Displays the two-dimensional chess board which you can use to move your pieces (instead of the regular three-
dimensional board).
Click the red button on the 2D board to close it.

See also
How to play Chess



Chinese Checkers unique actions and other menus



No Actions for this one
Actions menu (Chinese Checkers)



Current Standings
Game menu (Chinese Checkers)

Displays the Current Standings dialog box with information on the place standings for each player in the current 
game, along with the number of jumps played. (Players must finish the game to appear in the standings.)

See also
How to play Chinese Checkers



Statistics
Game menu (Chinese Checkers)

Displays the Statistics dialog box with information on the number of games played, and the place standings for 2-, 
3-, 4-, and 6-player games.

See also
How to play Chinese Checkers



Game Setup
Options menu (Chinese Checkers)

Opens the Game Setup dialog box which you can use to set the number of players in a game (2, 3, 4, or 6). With 
2, 4, or 6 players, each player's goal is the point area across from his or her starting point. With 3 players, each 
player's goal area is the starting area of the player to his or her right.

See also
How to play Chinese Checkers
Getting started
How the game of Chinese Checkers evolved
Adding or removing players
Changing a character player
Changing the current human player
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Dominoes unique actions and other menus



Pass
Actions menu (Dominoes)

Passes the turn to the next player when you can't make a play.
You can pass during play by:

Clicking Pass on the table.
Pressing Enter on the keyboard.
Choosing Pass from the Actions menu.

See also
How to play Dominoes



Current Standings
Game menu (Dominoes)

Displays the Current Standings dialog box with information on the number of hands won in the current game, the 
pip count (the number of points from opponents' unplayed bones), and the total score for the game.

See also
How to play Dominoes



Statistics
Game menu (Dominoes)

Displays the Statistics dialog box with information on the number of games played, won, and tied.

See also
How to play Dominoes



Game Setup
Options menu (Dominoes)

Opens the Game Setup dialog box which you can use to set various options for Dominoes, including number of 
opponents, and game and rule variations.

Option Description
Number of Players Sets the number of players (2, 3, or 4).
Bones In Hand Sets the number of bones you must choose to start the game (5 or 7).
Winning Score Determines the score that a player must reach to end the round of play (100, 200, or 300).
General Rules Start With Highest Doublet. A doublet is a bone with the same number of pips on both 

ends; 6-6 is the highest doublet possible.
Leave The Last Two Bones in the Boneyard. When boneyard picks are allowed, this option makes 

the last two bones unavailable for play.
Must Play If Possible. If checked, each player must play any bone from his or her hand that can be 

played. The player can't pass or pick another bone from the boneyard before making this play.
When this option is unchecked, a player can choose to pass or pick from the boneyard,
even if he or she has bone that can be played.

Game Variations Block, Draw, or Sebastopol. If you choose Sebastopol, you have the option of checking 
the Allow Sprout Rule, which means that branches can be extended before the first four 
plays after the set. If this option is unchecked, the first four branches must be set before 
any branches can be extended.

See also
How to play Dominoes
Getting started
How the game of Dominoes evolved
Adding or removing players
Changing a character player
Changing the current human player
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Pachisi unique actions and other menus



Pass
Actions menu (Pachisi)

Passes the turn to the next player when you can't move or you prefer to pass after using one die value to move.
You can pass during play by:

Clicking Pass on the board.
Pressing Enter on the keyboard.
Choosing Pass from the Actions menu.

See also
How to play Pachisi



Roll Dice
Actions menu (Pachisi)

Rolls the dice for your turn.
You can roll the dice during play by:

Clicking your starting base on the game board.
Pressing the Spacebar on the keyboard.
Choosing Roll Dice from the Actions menu.

See also
How to play Pachisi



Current Standings
Game menu (Pachisi)

Displays the Current Standings dialog box with information on each player's place standings (1st, 2nd, 3rd, 4th) 
and the number of spaces each has left to make it home.

See also
How to play Pachisi



Statistics
Game menu (Pachisi)

Displays the Statistics dialog box with information on the number of games played and won.

See also
How to play Pachisi



Game Setup
Options menu (Pachisi)

Opens the Game Setup dialog box which you can use to set the number of players and whether rolling three 
doubles in a row sends the piece closes to Home back to the Start.

Option Description
Number of Players 2, 3, or 4.
Three Doubles In A Row Go Directly to Start. Sends the piece closest to a player's home back to the 

starting area.
Continue Play. Player can pass on the third double and does not send a piece
back to the starting area.

See also
How to play Pachisi
Getting started
How the game of Pachisi evolved
Adding or removing players
Changing a character player
Changing the current human player
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Snakes & Ladders unique actions and other menus



Draw Ball
Actions menu (Snakes & Ladders)

Draws a ball for your turn.
You can draw a ball during play by:

Clicking the circle area by your player image.
Clicking the wheel crank in the lower right corner of the screen.
Pressing the Spacebar on the keyboard.
Choosing Draw Ball from the Actions menu.

See also
How to play Snakes & Ladders



Current Standings
Game menu (Snakes & Ladders)

Displays the Standings dialog box with information on the current place standings (1st, 2nd, 3rd, or 4th).

See also
How to play Snakes & Ladders



Statistics 
Game menu (Snakes & Ladders)

Displays the Statistics dialog box with information on the number of games played and the place standings totals 
for 1st, 2nd, 3rd, or 4th.

See also
How to play Snakes & Ladders



Game Setup
Options menu (Snakes & Ladders)

Opens the Game Setup dialog box which you can use to set the number of players for the game (2, 3, or 4).

See also
How to play Snakes & Ladders
Getting started
How the game of Snakes & Ladders evolved
Adding or removing players
Changing a character player
Changing the current human player
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Yacht unique actions and other menus



Roll Dice
Actions menu (Yacht)

Rolls the dice for your turn. You can roll up to three times.
You can roll the dice during play by:

Clicking the dice cup by your player image.
Pressing the Spacebar on the keyboard.
Choosing Roll Dice from the Actions menu.

See also
How to play Yacht



Keep Dice
Actions menu (Yacht)

Moves a rolled die to the keeper area of the Yacht board.
Choose each die you want to keep for your turn score by typing the number of the die (1, 2, 3, 4, 5, or 6) on the 
keyboard.
To return a die from the keeper area back to the play area for the next roll, press Backspace.

See also
How to play Yacht



Release Dice
Actions menu (Yacht)

Moves a die from the keeper area back to the play area of the Yacht board.
To return a die from the keeper area back to the play area for the next roll, press Backspace.
Choose each die you want to keep for your turn score by typing the number of the die (1, 2, 3, 4, 5, or 6) on the 
keyboard.

See also
How to play Yacht



Current Standings
Game menu (Yacht)

The score for all Yacht players is always displayed in score cards on the Yacht game screen (so the Current 
Standings menu command is not needed).
To peek at another player's score card when it isn't that players turn, click on the player's score display (located 
near the top of the player's name plaque) and hold down the left mouse button. The player's score pad appears as
long as you hold the mouse button down.

See also
How to play Yacht



Statistics
Game menu (Yacht)

Displays the Statistics dialog box with information on the total number of games played, the number of competitive
games played, won and tied, the average score, the high score, and the low score.

See also
How to play Yacht



Game Setup
Options menu (Yacht)

Opens the Game Setup dialog box which you can use to set the number of players for the game (1, 2, 3, or 4).

See also
How to play Yacht
Getting started
How the game of Yacht evolved
Adding or removing players
Changing a character player
Changing the current human player
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Zen Bones unique actions and other menus



Find Match
Actions menu (Zen Bones)

Automatically picks out two matching tiles for you when you get stumped. To remove the pair, choose Remove Pair
from the Actions menu.
You can make the game find two tiles that match during play by:

Pressing the letter M on the keyboard.
Choosing Find Match from the Actions menu.

See also
How to play Zen Bones



Remove Pair
Actions menu (Zen Bones)

After finding a matching pair of tiles using Find Match, use this option to remove that pair from the table.
You can automatically remove the two matching tiles during play by:

Pressing Enter on the keyboard.
Choosing Remove Pair from the Actions menu.

See also
How to play Zen Bones



Undo
Actions menu (Zen Bones)

Returns the two matching tiles that were most recently removed back on the table in their original positions.
You can undo a match removal during play by:

Pressing Ctrl+Z on the keyboard.
Choosing Undo from the Actions menu.

See also
How to play Zen Bones



Current Standings
Game menu (Zen Bones)

Displays the Current Standings dialog box with information on the number of matches found by each player for 
that game, the number of matches left, and total time spent.

See also
How to play Zen Bones



Statistics
Game menu (Zen Bones)

Displays the Statistics dialog box with information on Solitaire and Challenge Zen Bones games. The statistics 
include the number of Solitaire games played and won, the average number of matches found, and the current 
streak of wins or losses. The statistics also include the number of Challenge games played, won, and tied.

See also
How to play Zen Bones



Game Setup
Options menu (Zen Bones)

Opens the Game Setup dialog box which you can use to set various options for Zen Bones games, including 
number of players (1 or 2) and a timer.

Option Description
Timer Activates the timer. When the timer is checked, you have an allotted time in which you can

match tiles each turn. You can specify 15, 30, 45, or 60 seconds for each turn.
Game Variations 1 Player (Classic) . This is the classic, solitaire-style matching game.

2 Players (Challenge). This is the challenge version of the game in which each player must match 
pairs quickly. The player with the most matches by the end of the game wins.

Click Choose to select your human opponent.
Layout list Select a layout from the list by clicking its name.

Add. Opens the Layout Editor which you can use to create your own layouts and save 
them in the layout list.

Remove. Deletes the selected layout from the list.
General Tiles Face Down. This turns the matching game into a memory game as well.

See also
How to play Zen Bones
Getting started
How the game of Zen Bones evolved
Adding or removing players
Changing a character player
Changing the current human player
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Layout Editor
Options menu / Game Setup (Zen Bones) / Layout List / Add

Use this editor to create your own custom bone layouts and save them in the layout list.
To position the bones on the layout grid, click the screen in each spot where you want to place a bone. The total 
number of bones you place must be a multiple of four.
When you finish placing the bones and you want to save the layout, choose Done from the Layout menu. Type a 
name for the layout in the Layout Name dialog box that appears. Click OK to save the layout with that name. The 
name will appear in the Layout List.
To leave the Layout Editor without saving the layout, choose Cancel from the Layout menu.



Options menu stuff follows



Controls
Options menu

Opens the Controls dialog box which you can use to set various options for the game's atmosphere, including 
game speed, player attitude, and sound effects.

Option Description
General Animations. Check this option to see all the possible animations available for each 

game.
Sound Effects. Check this option to hear sound effects during game play.
Game Speed. Move the slider bar to adjust the speed of play (Right = Fast, Left = Slow).

Background Music Check this option to hear background music during game play. Click the music you want to
hear in the list.

Character Speech Check this option to enable characters to speak during play. Uncheck this option to 
eliminate all character talking.

Attitude Meter Move the slider bar to adjust the attitude and liveliness of character players.
Serious. Players still talk, but less frequently.
Talkative. Makes the character players extremely chatty and animated. Choose this 
setting to get a healthy dose of a player's personality!

See also
Setting game speed
Controlling sound effects, animations, or background music
Setting player attitude



Seasons
Options menu

Opens the Seasons dialog box which you can use to change the view outside the log cabin's window.
Choose System clock (Northern or Southern Hemisphere) to set the cabin seasons to match the Northern or 
Southern Hemisphere. Seasons are displayed automatically based on your system clock.
Choose Winter, Spring, Summer, or Fall to set the view to a specific season.

See also
Controlling sound effects, animations, or background music
Setting game speed
Setting player attitude



Players
Options menu

Use the Players tab in the Options dialog box to change the player at the current seat. To get to this screen quickly
during play, click (left mouse button) on the character you want to change.
You can assign the same character player to more than one seat (and achieve a clone effect!). You can assign 
more than one human player to a game, provided the players use different Sign In names.
Note If you choose the name of the human player that is already in the game, that player swaps seats with the 
character player you clicked to show the Players dialog box.
Click a player name to specify the player you want to place in the current seat. You have the option of selecting: 
Bart, Elayne, Gax, Harley, Jasper, Langley, Maurice, Miranda, Mrs. O'Shea, Primus, Robin, Nitro and Terra, or the 
list of human players signed-in to play.
Click OK to accept the new setting.

Tip To change the human player that is currently signed-in: Click that player's icon on the game screen, click the 
name of a different human player in the player list, then click OK. This player becomes the new default player for 
subsequent games.

Option Description
Player List Click a name in the list to select that player.

To add a new human player to the list, click New. Type the player name, choose a player 
silhouette, then click New.

Skill Level Beginner.
Intermediate.
Expert.

Apply To All. Applies the same skill level setting to all players.

See also
Adding or removing players
Changing a character player
Changing a player's seat
Changing the current player
Controlling sound effects, animations, or background music
Setting game speed
Setting player attitude



Backgrounds
Options menu

Opens the Backgrounds tab of the Options dialog box which you can use to change the look of the background 
shared by all the games. Hoyle Classic Board Games includes a variety of different backgrounds for your games.
The background you choose is used for all the games. You can't set a different background for each separate 
game, but you can change the background shared by all the games at any time during any game.

To change the background
1 Choose Backgrounds from the Options menu.
2 Click a background style in the list. A preview of the background appears.
3 Click Apply to see the background in the current game. Click OK to accept the background change.

See also
Controlling sound effects, animations, or background music
Setting game speed
Setting player attitude



Game Setup
Options menu

Opens the Game Setup dialog box which you can use to set various options for each game, including number of 
opponents and rules variations.
For more details, see each game's particular game setup options:
Backgammon Game Setup
Battling Ships Game Setup 
Checkers Game Setup
Chess Game Setup 
Chinese Checkers Game Setup 
Dominoes Game Setup 
Pachisi Game Setup 
Snakes & Ladders Game Setup 
Yacht Game Setup 
Zen Bones Game Setup 

See also
Controlling sound effects, animations, or background music
Setting game speed
Setting player attitude



Network menu stuff follows



Start Network Game
Network menu

Starts a network version of Hoyle Classic Board Games in which you can play Backgammon, Battling Ships, 
Checkers, Chess, Chinese Checkers, and Yacht on-line over the Internet, against opponents from all over the 
world.

Logging On (requirements for network play)
To play a network game, you must first connect to the Internet via your Internet Service Provider (ISP).    Start your
Internet software and leave it running, then return to Hoyle Classic Board Games and choose Start Network Game
from the Network menu. Alternatively, some Internet connection methods (like Windows 95 Dial Up Networking) 
will be automatically initiated by Windows 95 when you choose Start Network Game.
Note You must have at least a 14.4 Kbps modem, although a 28.8 Kbps of faster modem is strongly 
recommended.
Your Internet access must be a SLIP/PPP connection that supports WinSock32. Contact your Internet Service 
Provider if you are unsure whether they provide this type of access, or if you have questions regarding how to 
connect to the Internet.
Note If you use America Online to connect to the Internet, you must use the 32-bit version of AOL 3.0 made 
specifically for Windows 95. 

Using the Sierra Internet Gaming System (SIGS)
When you choose Start Network Game from the Network menu (and your Internet connection is open) the game 
then connects you to the Sierra Internet Gaming System (SIGS) server. You will need to provide a user name and 
a password to gain entry to the SIGS gaming area.
If you are a first time user, click New Member after providing your user name, a temporary password, and your e-
mail address. SIGS creates your membership with this information, then e-mails a confirmation of your password. 
If you have logged onto the server before, click Enter after providing your user name and password.
The Sierra Internet Gaming System provides help on how to navigate around the gaming rooms and how to create
or join a game. For details, click Help in the SIGS main gaming area screen.

Hoyle Class Board Games on the Internet
For two-player games (Backgammon, Battling Ships, Checkers, and Chess), the game starts automatically as 
soon as another player joins your game. For games that allow more than two players (Yacht allows up to four 
players; Chinese Checkers allows up to six players) you have the option of starting the game as soon as you have
two players, but you can wait for more players to join before starting.
When a game starts, all players screens change to the screen for that game. The game creator's Game Setup 
network-supported settings are used for all players that join his or her game. Other settings, such as character 
speech, sound effects, animations, music, and background images vary according to each individuals game 
settings (see Controls).
Some of the games allow the player who created the game to choose additional settings for the game.

Checkers. Game creator can choose his or her color.
Chess. Game creator can choose his or her color.
Chinese Checkers. Game creator can choose to allow computer characters to play and decide where 

players are positioned around the board.
Yacht. Game creator can choose to allow computer characters to play.

Note Be aware that character speech, sound effects, animations, and music can cause your game to move more 
slowly than your opponent's, which in turn slows the overall game progress. You may ask all players to turn their 
Animations option off to speed up play (see Controls).
Statistics are not tracked for network games. You cannot save or load games during network play, except with 
Chess.
With network Chess, the player who creates the network game has the option of saving and opening Chess 
games while playing over the network. Just as in a non-network play, the Save, Save As, and Open commands in 
the File menu are used for this purpose. Before you open a saved game during network play, you might want to 
chat with your opponent to confirm that he or she is ready for you to do this.

Chatting with players
You can chat with other players while you are playing network games using the SIGS Chat Log window and/or 



Chat balloons.
To chat with other players during a game using the Chat Log window:

Press Enter to start a new chat line. Type your message, then press Enter again to display your message to 
the other players. Press Esc to cancel the message.

To chat with other players during a game using the Chat balloon:
Click the balloon that appears next to your player icon, then press Enter to start a new chat line. Type your 
message. Press Enter again to display your message to other players. Click Esc to cancel the message.

If you experience persistent difficulties in establishing a connection with the SIGS server, see Network game 
troubleshooting.

See also
Starting a network game
Leave Network



Leave Network
Game menu (Network Play)

Ends a network board game, and returns you to the Hoyle Classic Board Games main screen.

See also
Starting a network game





This is a new secondary document for your project.
Click Topic (Ctrl+T) to add a new Help topic.

This file contains rules, history, and specific steps for each Hoyle Board game



Backgammon



How the game evolved
Backgammon

All board games that are older than today's fad pass through certain stages of development. These stages are 
well-known to game scholars, and they reappear in game after game. Backgammon has been through more of 
these stages than any other game, even Chess. Here are the Eight Stages of Board Game Evolution, as told 
through the history of Backgammon:
Claim the Egyptians as parents 
Work in the Romans, too (or the Greeks, or both) 
Inspire a creation myth 
Achieve literary immortality 
Ride along with the Arabs 
Conquer Europe 
Catch Edmond Hoyle's attention 
Pump up the volume with the Americans 

Claim the Egyptians as parents
Backgammon is not the oldest game in the world -- dice probably holds that distinction, though some people might
nominate politics -- but given the available evidence it has a good claim on the second spot. "An authentic, 
documented history of the ancient game of backgammon should probably begin either in the Garden of Eden or in 
the murky caves of the Neanderthal man," Alexis Obolensky and Ted James declare in Backgammon: The Action 
Game, and they're only half-kidding. Though Obolensky and James grandly assume that every 6,000-year-old 
reference to "dice" really means "backgammon," the game has been traced to the beginnings of Egyptian and 
Sumerian civilization. You can't beat this kind of heritage.
Backgammon boards not so different from our own have been found in the royal tombs of the Nile Valley and in 
the buried suburbs of Ur. If Mesopotamia, the site of Ur, was also the site of the biblical Flood, then perhaps Noah 
and his family filled their spare hours aboard the Ark by playing Backgammon!

Work in the Romans, too (or the Greeks, or both)
Even when their empire was at its height, the Romans always took the time for a round of Ludus Duodecim 
Scriptorum (literally, "a game with 12 lines"). The Romans usually shortened this name to Alea or Tabula (the latter
meaning "table"; when Backgammon entered Europe, it was called Tables). This was Backgammon with three dice
instead of two. Nero lost a fortune at the game. Caligula cheated at it. Antony played Tabula with Cleopatra; what 
stakes they played for is not known.

Inspire a creation myth
In the world of games, India has turned out the best creation myths. According to stories passed along by 
medieval Arab scholars, Backgammon was invented by an Indian philosopher who was trying to represent the 
concept of time physically, in a board game:

Backgammon objects What they mean
30 pieces days in a month
24 points hours in a day
12 points of one half-board months in a year
12 points of the other half-board zodiac signs
7 spots on opposite sides of a die days of the week*
2 dice day and night
* Also, the seven planets known at the time.

Achieve literary immortality
The Old and New Testaments are not noted for their analyses of board games. You won't find Backgammon in the 
Bible, but it did come close. H.J.R. Murray, in A History of Board Games Other Than Chess, gives as the first 
reference to Backgammon in world literature -- the Jewish Talmud! The Talmud, produced by 6th-century Jews 
living in Babylon, is a compilation of written commentaries on the Oral Laws of the Jewish people. Apparently, the 
rabbinical authorities of that time felt the need to at least mention Backgammon. (They didn't offer strategy hints.)
The Babylonian Jews used the Persian words for the game: "nard" and "nardshir." "Nard" was the wood marker 
used in the game. "Shir" means "lion," referring to the two types of pieces then in use: plain wood markers and 
markers with carved lions' heads.
A century later, Backgammon (Nard, that is) is mentioned in a Persian fictional work about the invention of Chess. 
Backgammon was supposed to have been invented as a riddle to pose to a king. (The Persians spun the same 



story about Chess as well.) So chalk up an Indian and a Persian creation myth for Backgammon.

Ride along with the Arabs
Typically in the history of games, the Arabs, after their conquest of Persia in the 7th century, learn all the games 
the Persians learned from the Indians, who may or may not have learned them from the Chinese. The Arabs raise 
the level of play in these games to unimagined heights and write the first books about them. They then invade 
Spain and Sicily, fight off the Crusaders, and trade with the Venetians, all of which leads to an exchange of ideas --
and games.
The Arabs adopted Backgammon immediately, but the Islamic religious authorities were troubled by the game and 
its gambling aspect (just as Chess had troubled them with its "graven images," which are forbidden by the Koran). 
Chess survived in the Islamic world because the players switched from the fanciful pieces used by the Persians to 
abstract pieces with no resemblance to people, animals, or anything else. Backgammon couldn't do without its 
dice, and in the 8th century it was banned. This ban was not successful. Though the Islamic courts threatened 
players with various penalties, the game continued to flourish -- a lesson the Catholic Church was fated to learn all
over again a few centuries later.
The first book about Backgammon was written by an Arab of the 9th century.

Conquer Europe
The Persian/Muslim Nard and the Roman Tabula met in France in the 11th century. The third dice was eliminated 
but the Roman name was retained, as can be seen from the forms Tabula took as it marched across the continent:
in Italy, Tavola; in Spain, Tablas; in Middle English, Tavel, then Tables; and so on. Backgammon (or Tables) began 
appearing in the literature of the period almost at once, by which we can track its progress even to distant Iceland 
(which it reached late in the 13th century).
The first European book to focus on Backgammon appeared in Spain in 1283. This book was primarily about 
Chess, and was compiled by scholars working under the direction of King Alfonso of Castile ("Alfonso the Wise"). 
A similar book by an unknown author appeared in England circa 1300.
As with most of the games that entered Europe in this era, Backgammon was taken up by the nobility and was 
soon competing with Chess for the position of most-popular game (both games were eventually dethroned by 
playing cards). As Backgammon filtered down to the masses, the Church tried to ban or at least contain it. These 
efforts failed. By the 1700s, Backgammon was the favorite pastime among vicars in the English countryside!
Innkeepers throughout Europe were soon providing Backgammon boards and sets to their customers, a tradition 
that goes back to the Roman empire. Obolensky and James report on a wall painting found in the excavation of 
Pompeii: "In one panel, a game is in process and an argument has ensued over points. In the second, an 
innkeeper is throwing the two battling players out of his tavern."

Catch Edmond Hoyle's attention
Given that Hoyle died in 1769, long before most of the games played today were invented, and given that in his 
lifetime he only wrote above five games, the odds are steeply against any game being able to make this 
connection. Happily for Backgammon, Hoyle was not only a devotee of the game, he also had many ideas about 
how it should be played. Edmond Hoyle, in fact, turned out to be the Alexander Cartwright of Backgammon. Just 
as Cartwright in the 1840s codified the laws of baseball, Hoyle in 1746 did the same for Backgammon in his first 
book of games. Most of Hoyle's rules of play are still in force (as are most of Cartwright's).
The modern game began with Hoyle, who had developed considerable clout in the game world by 1746. When he 
put together the hodge-podge of rules governing the game and decreed, among other things, that doublets should 
be played twice and that the scoring should include such subdivisions as "backgammon," "gammon," and "hits," 
people listened. And played.

Pump up the volume with the Americans
Americans couldn't figure out a way to improve on Chess, but in 1925 an American innovator whose name is 
apparently lost to us developed the concept of doubling. Doubling revived Backgammon and led to a worldwide 
Backgammon renaissance that continues today.
The word "Backgammon," incidentally, comes from the Middle English "gamen," meaning "game." It's thought that 
the name derives from the pieces occasionally having to go and reenter the board. In Scotland the game is called 
Gammon; in Spain, Tablas Reales (The Royal Tables); and in Italy, Tavole Reale (ditto). In France the name is 
Trictrac and in Germany, Puff, though how these names strayed so far from the Roman Tabula is not clear.

See also
How to play Backgammon
Getting started
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How to play
Backgammon

Backgammon is played by two players on a special board with 15 pieces to a side. The pieces making up each 
side are called stones. Though they may be of any color, the darker-colored pieces are called Black while the 
lighter ones are called White.
The board is divided into two halves, or tables, by a partition running down the center. This is called the bar. The 
outer table is on your left, the inner table is on your right. In each table there are six points (long, thin triangles).
The pieces move according to your throw of the two dice. The players roll the dice to see who goes first, with the 
higher roll winning. (If the numbers are the same, you just roll again.) The player with the higher number uses that 
for his first turn, if the rules are set that way (see Game Setup for more details). From then on turns alternate, and 
you always throw the dice to begin your turn. (The exception to this is when you are shut out, which can occur 
when your blot is on the bar. If your enemy's stones have crowded all available space so no possible points are 
open, you don't get to throw the dice and your turn is over. For details see, Sending blots to the bar.)
The object of the game seems odd at first: You win by being the first player to transport all of your stones off the 
board! To do that you must first get all of your stones into your inner, or home, table. Once they're all safely home, 
you can proceed to move them off the board. Pieces move from point to point.

Like a rolling stone
After you've thrown the dice to begin your turn, you can apply both numbers to one stone or each number 
separately to two stones. If, for example, you throw a 5 and a 4, you can move one piece a distance of nine points,
or you can move one piece five and a second piece four.
Note When you use both die numbers for one stone, the points must be open for each die value, just as they need
to be open for moving two stones separately.
If you throw doubles, say a 3 and a 3, you play that number four times rather than twice: you can move one piece 
12 points, or one piece nine points and one piece three, or two pieces six points each, or four pieces three points 
each.
A stone cannot land on a point occupied by two or more of the opponent's stones. You are not allowed to make 
that move, even if you have only one piece left and there is no other move you can make. A point occupied by two 
more stones is an indestructible fortress; that point is said to be closed or made. However, though you can't share
a point with enemy pieces, you can jump over them.
Any number of pieces of the same color can rest on one point. If necessary they are piled on top of each other. 
This keeps one side's pieces from encroaching on the other side's.
Moves are always compulsory, even when it's in your best interests to stand still. If you can only use one of the 
two numbers you rolled, then you must do so. You must always try to use the higher number.
Sending blots to the bar
A single stone resting on a point is a target. It's called a blot, and when you land directly on an enemy blot it's 
called a hit. The blot is then retired to the bar. The blot must be entered and become a stone again before you 
can move any of your other pieces. Plus, the lonely blot must enter the enemy's home table on an open point. For 
example, if you roll a 5-2, and if points 5 and 2 in the enemy's home table are open, you can choose either one 
and place your blot there. If you placed it on point 5, you can now move it two points.
If one of those points is occupied by a single stone of the enemy's, you can hit it and send it to the bar. If none of 
the points are open, if your enemy's stones have crowded all available space, you are shut out and you don't 
even get to throw the dice. Your blot remains on the bar and you can't move any other. Your turn is over.
When you've collected all of your stones in your home table, you can bear off: that is, remove all your stones from
the game, in the order determined by the dice. If the number you rolled is higher than the number of points you 
have yet to travel, you simply bear off the piece that's farthest away.
If you're hit after you've started to bear off, your stone becomes a blot on the bar. You must enter it and bring it 
around to your home table before you can go back to bearing off.

Gammon and Backgammon
The game ends when either player bears off his or her last stone. If the loser has borne off at least one stone, then
the loser has lost just one game. But if he or she has not borne off at least one stone, the loss counts double. This 
is called a gammon. If the loser has a stone left in the winner's inner table, or on the bar, the loss counts triple. 
This is called a backgammon.

Doubling



You can really ratchet up the stakes by using a tactic called doubling. Either player may make the first double of 
the game. You simply declare your intention to double before rolling the dice. Thereafter, the right to double 
alternates. When one player chooses to double, the other must decide whether to play on for a double game, or 
resign right there and lose the current value of the game. The doubling cube is used for this (a single die with the 
numbers 2, 4, 8, 16, 32, and 64 on it). The double for gammon and triple for backgammon both apply to the final 
score; this is in addition to whatever voluntary doubles have been made. Automatic doubling applies when the 
roll for first play results in like numbers on the two dice. You must specify this option on before play begins. 
To use the doubling cube in your Hoyle game, choose Game Setup from the Options menu and check the 
Doubling Cube option. To set the number of automatic doubles allowed, choose Game Setup from the Options 
menu and click the number.

Here are the shortcut keys available for Backgammon:

Actions Shortcut key
Double D
Roll Dice Spacebar
Resign S
Undo Ctrl+Z

See also
Shortcut keys
Getting started
How the game of Backgammon evolved
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Getting started
Backgammon

Before you begin the game, you may want to check the game setup to make sure all the game options are set to 
your liking. In the Game Setup dialog box for Backgammon, you have the option of choosing to use a doubling 
cube, setting the number of automatic doubles allowed, and setting first roll options. Choose Game Setup from the
Options menu to set these options.
When you are ready to start play, click your cup to roll the dice.
If you win the roll and you must use or have the option to use the first roll, move your pieces based on the roll of 
both you and your opponent's dice. If you cannot use the first roll, or choose not to, roll again, then move.
Move any stone in a counter-clockwise direction towards your home, which is the inner table (right side) next to 
you. Click and drag the stone to move it to the desired point.

Here are the shortcut keys available for Backgammon:

Actions Shortcut key
Double D
Roll Dice Spacebar
Resign S
Undo Ctrl+Z

See also
Shortcut keys
How to play Backgammon
How the game of Backgammon evolved
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Setting game rules and options
Backgammon

Backgammon has different game setup options, such as using a Doubling Cube during play, choosing the number 
of automatic doubles allowed, choosing the color you want to play, and whether you must use your first roll or roll 
again. You control Backgammon setup options using the Game Setup tab in the Options dialog box.

To set game rules and options
1 In the game you want to setup, choose Game Setup from the Options menu.
2 Make the changes you want to settings.
3 Click OK to accept the setup.

See also
How to play Backgammon
How the game of Backgammon evolved
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Viewing player statistics
Backgammon

You display player statistics during play by choosing Statistics from the Game menu. Click the player name, then 
click the Backgammon tab. The Statistics dialog box includes information on the number of games played and 
won, the net points, and the number of times you gammoned or backgammoned an opponent (see Gammon and 
Backgammon).

See also
How to play Backgammon
How the game of Backgammon evolved
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing the current standings



Viewing the current standings
Backgammon

You display the standings for the current game during play by choosing Current Standings from the Game menu. 
The Current Standings dialog box includes information on the number of games played and won, the net points, 
and the pip count (the number of your opponent's stones that do not make it home before you finish).

See also
How to play Backgammon
How the game of Backgammon evolved
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics



Battling Ships



How the game evolved
Battling Ships

Battling Ships is also known under its trademarked name, Battleship(tm). (In the British Isles it's called Battleships 
or Salvo.) How Battling Ships came to be is yet another mystery for game scholars. But the way the game is 
played, and the names involved, allow us to make a good guess as to when it came to be.
First, consider the British name of Battleships. One would expect that a naval-warfare simulation would include 
aircraft carriers. The British launched the first one, in 1918, though the true potential of these ships wasn't realized 
until the Second World War. Given the emphasis in the name, we can conclude that this game was developed 
while battleships still ruled the waves -- before 1939.
Second, consider the other British name, Salvo. In Battling Ships, you fire up to six shots from your fleet's guns at 
targets you can't see (perhaps because they're supposed to be at extreme long range). In the days of sail, 
warships had to get quite close to their opponents for their short-range volleys of cannonballs to have any effect. 
These volleys were called "broadsides," not salvos. Given the emphasis in this name, we can conclude that 
Battling Ships was developed after sail and wood had been replaced by steam and iron. The American Civil War 
saw the first use of steam-powered iron vessels, called ironclads, so the decade of the 1860s must be the earliest 
date this game could've been developed.
The word "battleship," though it was first recorded in 1794, was not applied to the big hulking monsters of the 
world's navies until well after the ironclad era. In fact, nobody used "battleship" much at all in the 1800s. Even 
when, in 1869, the British launched the first oceangoing, iron-hulled warship -- the first true battleship -- it was 
referred to as an "armored frigate."
But in 1906 the British sent the HMS Dreadnought to sea. They weren't fooling around this time. The Dreadnought 
carried all the biggest guns of its era and didn't bother with any of the small stuff. The launch of the Dreadnought 
touched off a race among the world powers for naval supremacy and brought the battleship into the public's 
imagination and everyday speech. Therefore, since no one has been able to determine an exact birthdate for 
Battling Ships, Hoyle Classic Board Games takes the bold step of declaring that date to be 1906 (or, at the 
earliest, the decade of the 1890s).

See also
How to play Battling Ships
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



How to play
Battling Ships

Battling Ships is a game for two people played on two 10x10 grids. This is the ocean on which your fleets will fight 
their battle.
Each side has a fleet consisting of an aircraft carrier (five squares long), a battleship (four squares), a destroyer 
and a submarine (three squares each), and a PT boat (two squares). You place these on your grid, out of sight of 
your opponent.
Each player can fire a salvo of up to six shots per turn. You choose the squares your missiles will strike. Hits and 
misses will be reported to you so you can plan your firing patterns.
A ship is sunk when every one of its squares has been hit. Play continues then in one of two ways: You can 
choose to have your barrage reduced for every ship you lose (the Aircraft Carrier Nimitz supplies 2 shots; all other 
ships supply 1 shot each), or choose to play with the same number of shots you started with.
The first player to sink all of the enemy's ships is the winner.

Here are the shortcut keys available for Battling Ships:

Actions Shortcut key
Fire (Missiles) Spacebar
Clear All (Targets) Backspace

See also
Shortcut keys
Getting started
How the game of Battling Ships evolved
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Getting started
Battling Ships

In the Strategic Command Center dialog box, click and drag the ships to place them. Click Rotate 90 to turn ships.
Before you begin the game, you may want to check the game setup to make sure all the game options are set to 
your liking. In the Game Setup dialog box for Battling Ships, you have the option of setting the number of missiles 
allowed per turn and whether you can see your opponent's sunk ships. Choose Game Setup from the Options 
menu to set these options.
Click a square on the screen to place your target. The lights on the right side of the playing grid indicate how many
shots you have left. When you finish placing all available targets, click Fire. Click Clear to wipe away your current 
target selections and choose new targets.

Here are the shortcut keys available for Battling Ships:

Actions Shortcut key
Fire (Missiles) Spacebar
Clear All (Targets) Backspace

See also
Shortcut keys
How the game of Battling Ships evolved
How to play Battling Ships
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Setting game rules and options
Battling Ships

Battling Ships has different game setup options, such as the number of missiles that can be shot by each player 
per turn and whether you can see the location of your opponent's sunk ships. You control Battling Ships setup 
options using the Game Setup tab in the Options dialog box.

To set game rules and options
1 In the game you want to setup, choose Game Setup from the Options menu.
2 Make the changes you want to settings.
3 Click OK to accept the setup.

See also
How the game of Battling Ships evolved
How to play Battling Ships
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Viewing player statistics
Battling Ships

You display player statistics during play by choosing Statistics from the Game menu. Click the player name, then 
click the Battling Ships tab. The Statistics dialog box includes information on the number of games played, won, 
and tied.

See also
How the game of Battling Ships evolved
How to play Battling Ships
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing the current standings



Viewing the current standings
Battling Ships

You display the standings for the current game during play by choosing Current Standings from the Game menu. 
The Current Standings dialog box includes information on the number of shots fired, hits, and ships sunk.

See also
How the game of Battling Ships evolved
How to play Battling Ships
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
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How the game evolved
Checkers

Checkers has always suffered from a bit of an image problem. It's a medieval offspring of Chess, and it had to 
grow up in the shadow of its parent, which was at the time wildly popular. And it took several centuries to find the 
right balance in the rules. Many people look upon Checkers as that game you play until you're ready to learn 
Chess, but this attitude is mistaken. Checkers is a game with its own depths and complexities. A supercomputer 
brought down the human champion in Chess (IBM's Deep Blue, 1997); it took a supercomputer just to earn a tie 
with the human champion in Checkers (the University of Alberta's Chinook, 1994).
The French mix and match 
The word "Checkers" enters the language 
Checkers catches on (slowly) 
The Scots take center-stage 
Checkers in the modern era 
An odd sociological footnote 

The French mix and match
Checkers is almost certainly a French invention of about the 12th century. It's a mixture of an old Moorish game, 
Alquerque (pronounced like the city of Albuquerque, minus the third and fourth letters), and Chess. Alquerque is 
the Spanish corruption of the Arabic "el-quirkat." The game was first mentioned in print in a Moorish book 
published in the 10th century, but its history goes much farther back. One of the ancient temples of Egypt has an 
Alquerque board engraved in its roof. (Since we know the ancient Egyptians didn't float in midair, we can assume 
that this board was meant as a decoration. The Egyptians must've loved their games to have used them in this 
fashion.)
Alquerque gave Checkers the 12-man army and the capture-by-jumping concept. Alquerque is played on a latticed
board, but the pieces occupy the intersections of the lines rather than the insides of the squares formed by the 
lines.
Chess provided the concept of the checkered board (a European innovation). When the French combined Chess 
and Alquerque, the Alquerque men moved off the intersections and occupied the Chess squares. Now all the new 
game needed was a name. Surprisingly, that too came from Chess.
When Chess came to Europe, it had no Queen; instead, a piece called the "Fers" (a Persian word meaning 
"counselor") stood beside the King. Because the men in Checkers moved like the Fers in Chess, the game itself 
was called Ferses, and the pieces, rather than the 12 flat disks we're familiar with, were 12 Ferses pilfered from 
sets of Chess pieces.
By the year 1500, the Europeans had replaced the Fers in Chess with the Queen -- in French, the "dame." The 
Queen also knocked the Fers off the checkerboard. (So now the French were using 12 Queens per army -- and 
when a Queen reached the last rank, it underwent a sex change and became a King. Interesting.) For the next 200
years the French referred to Checkers as Dames, a name that followed the game as it spread across the 
continent, from Turkey (Dama) to Scotland (where it is still referred to as Dams). In England, however, the game 
was called Draughts (pronounced "Drafts"), a Middle English word referring to a move made by the Queen in 
Chess. Draughts is the name the English have continued to use; the pieces are the draughtsmen and the board is 
the draughtsboard.

The word "Checkers" enters the language
The name "Draughts" never caught on in several rural, out-of-the-way pockets of England. People there referred 
to the game as Checkers, after the checkered board on which the game was played. Many of the Pilgrims who set 
up shop in Massachusetts in the 1600s came from those areas of England where Draughts was Checkers. They 
not only took the game with them when they came over on the Mayflower, they took the name as well. Checkers 
spread outward from Massachusetts (many New England Indian tribes adopted the game), and wherever English 
was spoken, Checkers was the name.

Checkers catches on (slowly)
The indefatigable H.J.R. Murray dug deep into medieval European literature to document the spread of Checkers. 
In his History of Board Games Other Than Chess, he reports finding only five mentions of the game in the years 
1200 to 1500. Four are French; one is English. (The English mention is from a poem by Chaucer, who cleverly 
plays up the confusion that might result in conversation if one person is talking about Chess and the other 
Checkers and neither knows it.)
In this period too the Church was busy banning every new game that popped up in Christendom, including Chess 
and almost all card and dice games. But Murray could find no such injunction leveled against Checkers. "It is 



difficult to resist the conclusion that the game cannot have been very widely known before 1500," he writes -- 
certainly not outside of France, England, and perhaps Spain.
Something happened to Checkers in those years leading up to the 16th century, something that made the game 
much more attractive. Up until then, there were two ways to play Checkers: a) you could choose not to capture 
when the opportunity came, or b) you were compelled to capture. Compulsory captures is what makes Checkers 
so interesting, and by the opening of the 16th century this form of play was dominant. (Odd rules from various 
corners of Europe, such as checkermen not being allowed to capture Kings, had also been ditched.) Checkers 
then spread eastward, first into Italy (where we have a report dated 1527) and elsewhere in Europe after 1550.

The Scots take center-stage
The first work in English to focus on Checkers in a serious manner appeared in 1756 (William Payne's Introduction
to the Game of Draughts). From here the Scots took over the game and in the following hundred years greatly 
expanded our knowledge of its possibilities. The Scottish influence is still seen in the names of some of the more 
popular opening systems, which bear the names of Scottish towns (Dundee, Edinburgh, Glasgow) and more 
fanciful notions (the Will-o-the-Wisp, the Laird & Lady, and the Ayrshire Lassie).
Given the stormy relations between England and Scotland in the years leading up to their unification, it's believed 
that the Scots learned the game of Checkers not from the hated English but from the Dutch (in whose armies 
many Scots fought in the 17th century). The Scottish "Dam" is certainly closer to the Dutch "Damen" and the 
French "Dames" than the English "Draughts."

Checkers in the modern era
Those of us who don't play in Checkers tournaments usually begin a game by just beginning. Whatever we like to 
play, we play. This style is called "Go As You Please" and on the professional level it results in numerous draws, 
due to the great knowledge these players bring to the game. The first world championship, held in 1847 (between 
two Scotsmen, of course), was a Go As You Please affair. In the 1890s the Two-Move Restriction was introduced, 
in which the first two moves of a game were chosen by lot from certain pre-approved combinations.
The Two-Move Restriction eliminated many draws, though not enough. The Three-Move Restriction was 
introduced at the 1934 world championship (between two Americans). The participants chose moves by lot from a 
list of officially sanctioned "three-move openings." This system is still in force today (though there's also a separate
tournament track for Go As You Please games). A third system, in which one man from each army is removed by 
lot before the first move, is less popular. (Hoyle's Checkers is solely Go As You Please.)

An odd sociological footnote
We all know the stereotype of Chess masters: they eventually go insane. Checkers masters keep their marbles, so
to speak, but they seem to die tragically. Some examples:
The first American world champion, Robert Yates, took the crown from the Scots in 1874. He died not long after in 
an accident at sea. He was 24.
The 1902 world champion, Scotland's Richard Jordan, was killed in a train accident.
In 1927, the United States walloped Great Britain in the Second International Checkers Match (Great Britain had 
done the same to the US in the first match, played in 1905). Sam Gonotsky, top scorer for the US team, died a few
years later. He was in his twenties.
In 1949, Willie Ryan tied defending champ Walter Hellman (both Americans). Ryan wasn't particularly young at the
time, but he died not long after, just weeks before he was scheduled to play Hellman in a rematch.
In 1951, Hellman defeated Maurice Chamblee (American) in a title match. Chamblee soon died, of course. He was
in his twenties.

See also
How to play Checkers
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings





How to play
Checkers

Checkers is played by two people on the same checkered board that is used for Chess, but there all similarities 
end. The pieces that make up your army are also called checkers (or simply men), and each army has 12 of 
them. The checkers of each army are the same color. Whichever colors are used, the side with the darker pieces 
is called Black and the side with the lighter pieces is called White.
The board is placed so that each player has a light-colored square in the corner on the right. The pieces move 
only on the dark-colored squares.
To begin a game, set your pieces up on the 12 dark squares of the first 3 rows of the board. Your opponent does 
the same.
By tradition, Black moves first. Moves alternate after that. You lose the game if your turn comes and you can't 
make any moves. This usually occurs because all of your pieces have been captured, but sometimes because the 
ones you have left have been immobilized by your opponent. If neither you nor your opponent has enough of an 
advantage to win, you can agree to a draw.
The pieces move one square at a time, always forward and always diagonally to an adjacent dark square. The 
exception to the one-square-at-a-time rule is when you are capturing, or jumping, an enemy piece. You can jump 
if your piece occupies a square adjacent to the enemy, and if there is an empty square on the other side of the 
enemy. That empty square is the one your piece will jump to. The enemy piece is then removed from the board.
Capturing is compulsory (when you choose this option in the Game Setup dialog box). If the opportunity to capture
comes up, you must take it. If you have the option of capturing a piece in either of two directions, you can choose 
which one to grab.
If, after capturing an enemy piece, you find yourself next to another enemy and the square beyond that one is 
empty, you can capture that second piece, too. And so on. You can change direction in these multiple captures, so 
long as you keep moving forward.

"King me"
The row of squares farthest from each player is that player's King row. On reaching the King row, your piece is 
crowned and becomes a King. Now it can move backward as well as forward. (If by jumping over one or more of 
your enemies you land on the King row, your new King can't continue jumping in the same turn even if the 
opportunity is right there. The act of being crowned requires that the new King end its turn on the King row.)

Here are the shortcut keys available for Checkers:

Actions Shortcut key
Resign R
Request Draw D
Pass Enter (This option is only available when the Must Jumped option is unchecked.)

See also
Shortcut keys
Getting started
How the game of Checkers evolved
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Getting started
Checkers

If you are playing Black (or Blue for frogs), you must move first. Click a piece and drag it to the square you want to 
move it to (forward and diagonally to an adjacent dark square).
Before you begin the game, you may want to check the game setup to make sure all the game options are set to 
your liking. In the Game Setup dialog box for Checkers, you have the option of setting the style of the checkers 
(standard or frogs), your color, and whether players must jump opponents when a jump is possible. Choose Game
Setup from the Options menu to set these options.

Here are the shortcut keys available for Checkers:

Actions Shortcut key
Resign R
Request Draw D
Pass Enter (This option is only available when the Must Jumped option is unchecked.)

See also
Shortcut keys
How the game of Checkers evolved
How to play Checkers
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Setting game rules and options
Checkers

Checkers has different game setup options, such as setting the style of the checkers (standard or frogs), your 
color, and whether players must jump opponents when a jump is possible. You control Checkers setup options 
using the Game Setup tab in the Options dialog box.

To set game rules and options
1 In the game you want to setup, choose Game Setup from the Options menu.
2 Make the changes you want to settings.
3 Click OK to accept the setup.

See also
How the game of Checkers evolved
How to play Checkers
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game speed
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Viewing player statistics
Checkers

You display player statistics during play by choosing Statistics from the Game menu. Click the player name, then 
click the Checkers tab. The Statistics dialog box includes information on the number of games played, won, lost, 
and drawn.

See also
How the game of Checkers evolved
How to play Checkers
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
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Viewing the current standings



Viewing the current standings
Checkers

Because you can easily determine the number of pieces jumped and crowned, the Current Standings menu 
command is not used for Checkers.

See also
How the game of Checkers evolved
How to play Checkers
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
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Chess



How the game evolved
Chess

"The game of Chess is a lake, in which a mosquito can bathe and an elephant can drown."
--Indian proverb

Archaelogists have more than once dug up game pieces that could be chessmen. Some of these items have been
judged to be thousands of years old. Did Roman senators, Greek philosophers, or even Egyptian pharaohs play 
some primitive form of Chess? Was Chess played by the waters of Babylon and in the courtyards of Ur? Given the
available evidence (or rather, the lack of almost any evidence), it seems doubtful. Nathan Divinsky, writing in his 
admirable The Batsford Chess Encyclopedia, sums up the prevailing view: "It seems unlikely that Chess existed 
long before the year 600 without any references in articulate Greece or in businesslike Rome."
The oldest Chess pieces that everyone agrees are Chess pieces date from about the year 600. That's also the 
approximate date of the earliest reference to Chess in world literature. The writer is Persian, and in his text he 
mentions a game similar to ours that has been obtained through trade with India: "Chaturanga." If you allow a few 
decades for a new pastime to soak so far into a culture that people begin to write about it, and for that pastime to 
travel to Persia, we can guess that Chess was invented in India in the 6th century AD.
War by other means 
Chess, the slow-motion game 
Chess hits the road 
'The Royal Game' earns its nickname 
The European makeover 
Liberty, Equality, Fraternity, and Chess 
Going global 
The Information Revolution 

War by other means
Chaturanga is a Sanskrit word meaning "quadripartite," or divided into four parts. The Indian army of that time was 
also called Chaturanga, and had four divisions: elephants, cavalry, chariots, and infantry. This suggests two 
theories to explain how Chess came to be:
1. Chess was a substitute for war, or a bloodless training ground for war.
2. Chess was a way to recreate real life in miniature, as we do today when we play board games that let us buy 

and sell "property" with fake money, for example.
The moves in Chaturanga were determined by rolling dice. This suggests one more creation theory: that this 
ancient form of Chess was a way of foretelling the future, or of obtaining messages from gods. David Hooper and 
Kenneth Whyld, in their Oxford Companion to Chess, offer this scenario:
By controlling the fall of objects on to a divination board the gods could communicate with men. At a later stage 
dice were added to determine the moves of the pieces and further reveal the celestial mind. Then someone was 
sacrilegious enough to convert this process to a game, perhaps eliminating the dice. The person who secularized 
the religious process has, perhaps, the best claim to be the 'inventor' of Chess.

Chess, the slow-motion game
Chaturanga was a four-player game. Each player had eight pieces: four pawns, a boat or chariot (our Rook), a 
horse (our Knight), an elephant (our Bishop), and a King. The moves were determined by rolling red, green, 
yellow, and black dice. (We don't really know how a set of dice determined moves on a chessboard, as no how-to 
guides survive from that era.) The elephant could move only two squares on a diagonal, though it could jump over 
any piece in its path. The pawn didn't have the option of moving two squares on its initial move, and on reaching 
the eighth rank couldn't be promoted to anything of importance. Castling didn't exist. There were no Queens, with 
their explosive power to change the course of a game in a single move. The Rook, Knight, and King moved as 
they do today. Try conducting a game with these rules. Be sure to set aside lots of time!
You'll have to make your own chessboard, too. The ancients used a 64-square board, but none of the squares 
were colored. (That was a European invention.)

Chess hits the road
The four-player version disappeared almost as soon as Chess left India. The Persians played only the two-person 
variety. Each player now had a 16-man army, as we do today, but the pieces were just as limited as described 
above, even the new "counselor" piece, which stood beside the King. (It's possible that the Kings from the two 
discarded armies of the Indian game became counselors in the Persian.) The counselor could only move one 
square diagonally, making it hardly more powerful than a pawn. Two-player Chess was every bit as slow as four-



player.
The Persian game could be played with or without dice. The use of dice didn't stop for at least another half a 
dozen centuries. The last mention of dice appears in a European literary work of the 13th century, in which a 
gentleman asks the object of his affections, "Lady, which game will you play? Will you have it with moves or with 
dice?"
The westward dispersal of Chess accelerated in the 7th century when the Arab empire overran Persia. In the next 
four centuries the Arabs produced the best players in the world. The names of some of these champions, and 
even much of their writings and many of the endgame problems they composed, are still known to us today.
Chess also ventured eastward, and as it traveled through Asia it evolved in far different directions from the game 
Westerners know. In Chinese Chess, for example, pieces are placed not within squares but on the intersections of 
the lines. A river divides the 9-square by 10-square board; each player has a fortress to shelter in; some pieces 
can't leave the fortress, some can't cross the river; some of the pieces resemble ours, but there are no Queens. 
Checkmate is still the aim.
Japanese Chess, commonly called "Shogi" in English-speaking countries, came to Japan from China by way of 
Korea. Shogi is played on a 9x9 board. The pieces are set up on three rows instead of our two. As in Chinese 
Chess, there are no Queens. The more recognizable units (to Westerners) are the Kings -- but each player has 
three of them. Even with three Kings, the object of the game is still checkmate. Most notable divergence from the 
Western game: captured pieces change sides!

'The Royal Game' earns its nickname
Chess took several paths into Europe. The Arabs invaded the Iberian Peninsula, where the kingdoms of Spain and
Portugal would one day rise, and the island of Sicily in the 8th century, and naturally brought Chess along with 
them. The rising Italian city-states, the nucleus for what would one day become Italy, were building economic 
empires in the Mediterranean; traders from Venice and Genoa soon discovered Chess. No doubt at least a few 
Crusaders learned Chess while hacking their way through the Holy Land. Chess entered Central Europe through 
the Balkans and invaded Russia through Central Asian trade routes. Even the Vikings learned Chess and helped 
to spread it through the more northern lands. By the year 1000, Chess was well-known throughout Europe (though
there was no common set of rules).
In the Islamic countries, people of all social classes played Chess. In the European countries, at least in the 
Middle Ages, Chess was a game of the nobility (hence "The Royal Game"). Aspiring knights were instructed in 
Chess as well as in how to joust, slay dragons, and court ladies. In Europe as in Arabia, women were encouraged 
to play, and in fact Chess was often referred to as a "game for lovers." In the Camelot stories, Lancelot and 
Guinevere played Chess.
Though the Church occasionally tried to ban Chess (the dice aspect was particularly troubling), the game attracted
many followers within religious orders, where it was often seen as a parable of good and evil. "The man who 
surrenders to sinful thoughts will always be held in check by the Devil and will lose his soul to mate if he does not 
know how to protect himself," wrote one theologian in 1300.

The European makeover
The period 1400-1600, the ebbing of the medieval era and the flowering of the Renaissance, was the incubator of 
modern Chess.
The Europeans gave the King a Queen, with all the powers she enjoys today. They also gave the Bishop its 
diagonal strength and the pawn the choice of opening with a one- or two-move step. The Europeans invented 
castling and the concept of "promoting" a pawn to a Queen to "reward" it for successfully completing its journey 
across the battlefield. Suddenly Chess was considerably faster and the pieces packed more of a punch!
We would be right at home on a chessboard in this time period. For one thing, we could play on a checkered 
board. Dice and Chess had at last parted company, so we could be sure that any game we played would be a true
contest of skill. We could expect everyone to be playing by the same rules.
We could even consult a Chess book for advice. The earliest known typeset Chess book appeared within 50 years
of the invention of the printing press (late 1500s). The author devoted a number of pages to the old style of play, 
with its less-powerful and decidedly slower pieces, but this was the last work to do so. The history of the game we 
call Chess now centers around developments in Europe and the Americas.

Liberty, Equality, Fraternity, and Chess
In the Western world, the 1700s were the years of the common people, in Chess as well as in politics. Among the 
upper classes, gambling replaced Chess as the amusement of choice, but Chess had already filtered down to the 
everyday man (though women still played, Chess was beginning to be considered a "man's" game).
The 18th century gave us revolutions, the first stirrings of the Industrial Revolution, and the concept of the Chess 



club. In the great cities of Europe, entrepreneurs established Chess places (often called "resorts" or "divans") 
whose reputations still endure. The first Chess professionals appeared. Rather than relying on one wealthy patron 
for their daily bread, these hardy souls played Chess for money at the new coffeehouses, gave lessons, and wrote
books. (It was in this century that the flood of Chess books began, which today form the largest body of writings on
any game ever invented.)
Benjamin Franklin, who seems to be responsible for so many firsts in American history, can also be credited with 
the first American writing on Chess: the essay The Morals of Chess (1786). Chess, Franklin wrote, teaches 
"foresight, by having to plan ahead; vigilance, by having to keep watch over the whole chessboard; caution, by 
having to restrain ourselves from making hasty moves; and finally, we learn from Chess the greatest maxim in life, 
that even when everything seems to be going badly for us we should not lose heart but, always hoping for a 
change for the better, steadfastly continue searching for the solutions to our problems."

Going global
In the 1800s, the clubs of the previous century reached out to each other through the new postal services. One of 
the earliest and most famous correspondence matches was the four-year battle between the Edinburgh and 
London clubs (1824-28). The distance the letters traveled was about 400 miles, and each letter took three days to 
arrive. Edinburgh won the match but Chess won a much larger victory, as the newspapers covered the games and
exposed a wide readership to some very exciting play. In the 1830s clubs in different countries began to 
correspond.
The greatest players of each era had traveled to other countries and tested themselves against the competition 
there, and fledgling organizations had put together an occasional tournament of champions, but in the 19th 
century these activities became systematized and commonplace. In 1834, the Frenchman Louis Bourdonnais 
burnished the honor of France by defeating the British champion, Alexander McDonnell; the British exacted 
revenge in 1843 when Howard Staunton trounced the French champion, Pierre Saint-Amant. The first international
tournament soon followed (London, 1851). In 1872 the German master Wilhelm Steinitz, having defeated 
everyone in sight, declared himself the world champion; the process of selecting a world champion has continued 
to this day.
By the end of the 1800s the laws of Chess had been standardized, as had the shapes of the pieces used in 
tournament and match play (the Staunton design, named for the design's principal booster). There were Chess 
organizations on the city, state, and national levels, and a system for awarding the coveted title of "master" to the 
best players. Chess clocks were being used for all serious games, which prevented players from trying to win by 
"outsitting" their opponents!

The Information Revolution
The 20th century has seen four far-reaching developments in Chess. These are going to make the 21st century an
interesting one for Chess players! In no particular order, these are:

The computer. The first "Chess-playing machine" appeared in 1769 (there was a little man hidden inside). 
Two centuries later, computers can play as well as the human champion of the world (as we saw in February 1996, 
when Garry Kasparov had to overcome a first-round defeat to take his match with Deep Blue, and in the April 1997 
return match, when Deeper Blue psyched out the exasperated Russian). Computers now act as study aids, research 
tools, and sparring partners for professional players, as instant and always available opponents for the rest of us, and
have contributed enormously to our knowledge of the endgame.

Women players entering the top levels of play. Until fairly recently, Chess was an all-boys club, and it was 
felt that women just couldn't cut it at the top level of competition. The Polgar sisters of Hungary (among others) have 
smashed that perception; all three are grandmasters, and one (Judit) ranks among the top 20 players, period.

Chess in the schools. The former Soviet Union began the practice of teaching Chess as part of its standard 
curriculum -- a practice that has contributed enormously to the iron grip the Russians have held on world Chess since
the end of World War II. Now many Western nations are at last following suit. 

A global Chess organization. The Federation Internationale Des Echecs, or FIDE (pronounced FEE-day), 
has had its troubles, but since 1924 has been a force for unification and world standards. FIDE maintains a numerical
rating system for master players, awards titles, organizes the world championship, and runs a biennial "olympiad" that
brings together teams from dozens of countries.

See also
How to play Chess
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music



Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
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How to play
Chess

When you set up the board to play Chess, there should always be a dark square in the left corner nearest you and
a light square in the right corner. Remember: "Light on the right."
The armies are always referred to as White and Black, though Chess pieces are available in many colors. The 
person commanding the White, or lighter, pieces always moves first. (A player can never refuse to move, no 
matter how disastrous his options may be!)
Each army has 16 pieces: one King, one Queen, two Bishops, two Knights, two Rooks, and eight pawns.

Rules of chess
The King 
The Queen 
The Rook 
The Bishop 
The Knight 
The Pawn 
Relative Values of the Chess Pieces 
Check and Checkmate 
Drawn Games 
Castling 
Chess Notation 

The King
If the King is trapped with no escape possible, the game is lost. Therefore the King is by far the most valuable 
piece on the board. However, as a fighting unit His Highness is simple and slow. The monarch can move in any 
direction (horizontally, vertically, or diagonally), but only one square at a time.
(There is one exception to the King's one-square-per-move plodding. See below for an explanation of castling.)
The King can capture an enemy soldier only if that soldier is occupying a square adjacent to the King. (Capture 
describes the removal of a piece during a game. Captures are always optional in Chess, except where the survival
of the King is concerned -- see the sections on check and checkmate.) The soldier is removed from the board and 
the King steps onto the square the soldier had guarded.
All of the pieces (except, in one special case, the pawn) capture by removing the enemy piece from the board and 
then occupying the enemy's square. Once a piece is gone, by the way, it's gone: if you lose your Queen, you won't
have the use of a Queen for the remainder of the game. (Unless you are able to promote a pawn! See the section 
on pawns below.)
Unlike Checkers, it's illegal in Chess to capture more than one piece at a time. 

The Queen
The White Queen, at the beginning of the game, stands on a light square in the center of the back rank; the Black 
Queen stands on a dark one. Two handy mnemonics for remembering where to start the Queen are "Queen on 
her own color" and "The Queen's dress matches her shoes." The King takes his station on the center square 
closest to the Queen.
The Queen, as a soldier in your army, is as swift as the King is slow. The Queen can move in any direction, and 
can charge from one end of the board to the other in the same turn.
There are two things the Queen cannot do. First, the Queen can't jump over another piece, whether friend or foe. 
(This is true of all the pieces, except the Knight.) The sovereign must either stop before running into the 
obstruction or, in the case of an enemy soldier, capture it.
Second, the Queen cannot change directions while moving. If the Queen sets out on a diagonal course, for 
example, that diagonal must be kept to. (Again, this is true of all the pieces, except the Knight.)

The Rook
Each army has a pair of Rooks. Each Rook occupies a corner of the board when beginning a game. The Rook has
half the firepower of a Queen, as it moves vertically and horizontally but not diagonally.

The Bishop
You have two Bishops in your arsenal. Centuries ago, the Bishop was called the "Counselor," and you can 
understand why when you look at the Bishops' initial positions: one on the Queen's left and one on the King's right,
as if one of the royals might ask them for advice.



The Bishops move diagonally only. A Bishop can never leave its assigned color.

The Knight
Two Knights make up your cavalry. They are stabled one on each flank, between the Rook and the Bishop.
The Knight is the oddest soldier in your army, and the one that gives new field marshals the most trouble. That's 
because the Knight can do two things that no other Chess piece can:

The Knight leaps over any piece that lies in its path, friend or foe.
The Knight changes direction as it leaps.

When the Knight is positioned in or near the center of the board, it can leap to any of eight possible squares.

Though the Knight jumps as if it were a piece in Checkers, it can't capture that way. The Knight can only capture an 
enemy piece if that piece occupies one of the Knight's landing zones.

The Pawn
The stubborn, one-step-at-a-time pawn has a poor reputation. We call people pawns when they appear to be 
powerless. And yet the pawn is the heart of Chess. Never take your infantry for granted!
The pawn has three distinguishing characteristics:

It's the only piece that moves in only one direction: forward.
It's the only piece that captures in a different manner than the way in which it moves. The King, Queen, 

Rook, and Bishop capture whatever lies in their path; the Knight captures whatever occupies the square it lands on; 
the pawn moves in a straight line, but captures diagonally. (The enemy must be on an adjacent square. The pawn 
occupies the square that held the target piece.)

It's the only piece that can transform itself into a unit of vastly greater power.
On its first move the pawn has the option of moving one square or two. After that, the pawn may only move one 
square at a time.
When a pawn fights its way through to the last rank on the opposite side of the board, it may be exchanged for any
other piece (except a King or another pawn). The new piece begins its career on the square the pawn had 
occupied. Every time one of your pawns reaches that last rank, you may trade it in for something else.
The pawn has one other trick to play, and this may be the most confusing move of all. Say that a White pawn has 
penetrated Black's camp.

Black could advance his pawn one square, stopping to attack the invader.



If instead Black sends his pawn ahead two squares, he bypasses the White pawn, and seems to give White no say in
the matter.

In fact, the bypassed pawn has the right to capture the pawn that had rushed by as if it had stopped after just one 
square.

This is called capturing en passant, a French term for "in passing."
The en passant capture works for Black as well as for White, of course. It's also entirely optional.

Relative values of the chess pieces
It is vital that you have a clear and reliable notion of the value of each unit under your command. Just as the 
Pentagon must know what it costs to field an army, you must know, too. If not, you may never get your money's 
worth when you and your opponent begin capturing each other's pieces. The following table is based on five 
centuries of practical play. It takes the pawn as the basic unit and calculates each piece's value in those units.
{bmc 
What does this table tell us? Suppose you can capture a Bishop while letting your opponent capture your Knight. 
No harm done: Bishops and Knights are the same value. (An even capture is called an exchange.)
However, if you capture a pawn and your opponent captures one of your Bishops, you've made a poor bargain. 
Chess players say you have "lost the exchange" (your opponent has "won the exchange").
By knowing the relative values of the pieces we can tell which captures would be profitable, which would be costly,
and which would be even. Weigh captures and exchanges carefully. When a player obtains an edge in material, he
is much more likely to win the game. Superior force usually wins!

Check and checkmate



Your objective on this battlefield is to attack the enemy King in such a way that it cannot escape. An attack on the 
King is called a check. If the King cannot escape the check, then the check is actually checkmate, and the 
attacking force has won the game.
When your King is checked, you must drop everything and rush to his defense. There are three ways to fend off a 
check:

Move out of the path of the attacking piece.
Block the path of the attacking piece with one of your own pieces.
Capture the attacker.

If your King is in check and you can't move, block, or capture, then you've been checkmated. (Note that in Chess 
the King is never actually captured. If the monarch is in check and unable to do anything about it, the game is 
over.)

Minimum requirements for checkmate
In certain situations, with certain combinations of pieces, it's impossible to checkmate even a lone King. Bishop, 
Knight, and King are the minimum requirements (even the professionals have trouble with this one!).
A King and one Bishop can't enforce checkmate against a lone King. (Since the Bishop travels on only one color, 
the hostile King is safe whenever he occupies a square of the other color.)
Nor can a King and a single Knight enforce checkmate. In any given position there are just too many squares not 
controlled by the Knight. In fact, a King and two Knights can't pull this off either.

Drawn games
So far it may seem as if all Chess games end in victory for White or Black, just as all baseball games end in a win 
or a loss. Actually, a game of Chess may end in a draw (a tie). There are several ways in which a game may be 
drawn:

Draw by Agreement. The players can agree to a draw. This may happen for various reasons: because 
neither player thinks the game can be won, because there isn't enough time to finish the game, or even because the 
position in the game is a crashing bore!

Draw by Perpetual Check. This refers to a position in which one player can keep checking the other player's 
King, move after move after move, with no possibility of the defending player being able to stop the checks. The 
assumption here is that the player doing the checking is at a disadvantage in some way, and is deliberately forcing a 
draw rather than suffering a loss.

Draw by Insufficient Material. See Minimum requirements for checkmate above.
Draw by Stalemate. This is a situation in which the player whose turn it is to move is not in check but has no 

legal moves.
Draw by Repetition of Moves. For this one you'll need to keep a record of the moves in the game using 

Chess notation (see below) if playing another human; against a computer opponent, the computer will do it for you. If 
the same position occurs three consecutive times, the game is drawn.

Draw by 50-Move Rule. You'll need to record the moves for this one, too (unless you're playing a computer). 
If a player can demonstrate that the last 50 moves have been made without the capture of a piece or a move by a 
pawn, that player may claim a draw. (This rule is most often used when one side has only a King.)

Defending the King: Castling
If you want to ensure a long life for your King, you'd better castle. Castling is the only maneuver in Chess that 
involves the simultaneous movement of two pieces: the King and one of the Rooks. Castling is carried out with the
goal of transferring the King to a safer refuge at the side of the board.
There are two types of castling: Kingside, which involves the King and the King Rook (the one in the corner closest
to the King), and Queenside, which involves the King and the Queen Rook (the one in the corner farthest from the 
King).
This is the board with the Kings and Rooks prior to castling.



In Kingside castling, White moves his King two squares to the right. The King Rook hops over the King to the square 
on the King's immediate left. For Black, Kingside castling means just the reverse: the King moves two squares to the 
left, and the King Rook hops over to the square on the King's immediate right.

In Queenside castling, White moves his King two squares to the left. The Queen Rook hops over the King to the 
square on the King's immediate right. For Black, the King moves two squares to the right, and the Queen Rook hops 
over to the square on the King's immediate left. Note that in Queenside castling, there are three squares between the
King and the Rook at the start of the maneuver. The King doesn't end up as deep in a corner as in Kingside castling, 
but the Rook is brought a step closer to the action in the center.

Which kind of castling is better depends on the particular circumstances of a given game. With time and experience 
will come an understanding of when to castle and on which side of the board.

When castling isn't possible
There are seven restrictions on castling. Four are temporary (castling might be possible later in the game) and 
three are permanent (castling will not be possible, period). 
Here's the list of temporary restrictions:

If your King is in check, you can't escape by castling out of it. You can't castle out of check.
If a King must travel across a square controlled by an enemy piece, you can't castle. (You can't castle out of 

check, and you can't castle through it, either.) There's no problem if the Rook rather than the King must pass across a
contested square.

If the King would end up on a square controlled by an enemy piece, you can't castle. (You can't castle out of 
check, you can't castle through it, and you can't castle into it.)

If a square between your King and the Rook you want to castle with is occupied, whether by one of your own
pieces or one of your opponent's, you can't castle.



These are the permanent restrictions:
If a player has moved his King before he's had a chance to castle, he can't castle.
If a player has moved his King Rook before he's had a chance to castle Kingside, he no longer has the 

option of castling Kingside.
If a player has moved his Queen Rook before he's had a chance to castle Queenside, he no longer has the 

option of castling Queenside.
Even when castling is possible, you can only do it once per game.
There's much to remember about castling. It may seem like too much to remember. But it's the single most 
important action you can take to protect your King. Castling defends and attacks at the same time: simultaneously 
entrenching the King behind a stockade of pawns on the flank and bringing the long-range firepower of the Rook 
to bear on the center.

Chess Notation
To help us describe the action in a game, we call a horizontal line of squares a rank and a vertical line a file. Each 
rank has a number and each file has a letter.

Chess notation uses abbreviations for the pieces:
King = K
Queen = Q
Bishop = B
Knight = N
Rook = R
(There is no abbreviation for the pawn.)
A move is described by listing the piece, the departure square, and the arrival square. For example, a Rook moving 
from a1 to a8 is recorded as Ra1-a8 (or, if you want to save space, as Ra8). A pawn moving from e7 to e5 is recorded
as e7-e5 (or simply as e5). A capture is described in the same way; you simply list the move the capturing piece 
made.
Castling is recorded by the King's move from its starting point to its ending point (Ke1-g1 or Kg1).
Check is noted by adding a plus sign at the end of a move. Checkmate is two plusses.

Capturing en passant is noted by adding the abbreviation "e.p." at the end of a move.
Pawn promotion is indicated by parentheses: e7-e8(Q) or a7-a8(R), for example. The letter inside the parentheses
shows what piece the pawn was promoted to.

Here are the shortcut keys available for Chess:

Actions Shortcut key
Resign R
Request Draw D
Undo Ctrl+Z

See also
Shortcut keys
Getting started
How the game of Chess evolved
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Getting started
Chess

If you are playing White, you must move first. Click a piece near its base and drag it to the square you want to 
move it to. (You can also select a piece by clicking anywhere on its square.)
Before you begin the game, you may want to check the game setup to make sure all the game options are set to 
your liking. In the Game Setup dialog box for Chess, you have the option of setting your color and whether the 2-
dimensional board is displayed for moving pieces. Choose Game Setup from the Options menu to set these 
options.

Here are the shortcut keys available for Chess:

Actions Shortcut key
Resign R
Request Draw D
Undo Ctrl+Z

See also
Shortcut keys
How the game of Chess evolved
How to play Chess
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Setting game rules and options
Chess

Chess has game setup options for setting the color for your side (Black or White), showing or hiding the 2-D chess
board for play, changing the layout of the pieces between turns, and setting which side has the next turn. You 
control Chess setup options using the Game Setup tab in the Options dialog box.

To set game rules and options
1 In the game you want to setup, choose Game Setup from the Options menu.
2 Make the changes you want to settings.
3 Click OK to accept the setup.

Changing the Board Layout
The Board Layout option allows you to rearrange the layout of your pieces and your opponents pieces before 
continuing play (only when it's your turn). Use this option to rearrange the game pieces and try out different 
strategies and tactics with different layouts.

To move a piece
Drag pieces on the miniature board to reposition them.

To add a new piece to an empty square
You can only add a new piece if it doesn't duplicate a piece that is already on the board. Add a new piece by 
dragging a piece from the right (outside of the board) onto a square. Or, with the piece (outside of the board) 
highlighted, click an empty square to add that piece.

To remove a piece
Right-click a piece or drag it off the board to remove it.

To clear the entire board (except the two Kings), click Clear button.
To return the pieces on the board to match your original game layout, click Reset.

After you set the pieces up, choose Black's Turn or White's Turn to decide who goes first.
You can arrange the board or change the turn only when it is your turn to play. You can also use these options 
during network games, although you should use caution when doing this, since your opponent will not take kindly 
to your rearranging the board without asking first.

See also
How the game of Chess evolved
How to play Chess
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Viewing player statistics
Chess

You display player statistics during play by choosing Statistics from the Game menu. Click the player name, then 
click the Chess tab. The Statistics dialog box includes information on the number of games played, won, lost, and 
drawn.

See also
How the game of Chess evolved
How to play Chess
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing the current standings



Viewing the current standings
Chess

You display the standings for the current game during play by choosing Current Standings from the Game menu. 
The Current Standings dialog box includes information on the number and rank of pieces captured up to that point 
in the game.

See also
How the game of Chess evolved
How to play Chess
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
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How the game evolved
Chinese Checkers

Chinese Checkers owns the oddest name in the Hoyle Classic Board Games package: It wasn't invented in China 
and it has nothing to do with Checkers!
Everyone agrees that this game first appeared in the late 1800s, and that it first became popular in Sweden. This 
inventor simply took the Greek game of Halma (meaning "jump" or "leap") and changed its look. Halma is played 
on a square board, Chinese Checkers is played on a board shaped like a six-pointed star. Halma uses flat pieces 
moving from square to square, Chinese Checkers uses marbles moving from hole to hole. In both games, the 
object is to be the first to occupy an enemy camp with your own pieces.
Although the pieces in Chinese Checkers move by jumping or leaping another piece, as in Checkers, this doesn't 
mean the two games are related. In Checkers, the jump is part of the business of capturing; Checkers is a war 
game, and the piece jumped is removed from play. In Chinese Checkers, the jump is just one way of getting 
around the board; Chinese Checkers is a racing game, and the piece jumped stays where it is.
By the way: Chinese Checkers is indeed played in China. (Perhaps the Chinese learned the game from a Swede.)
In China they use 10 pieces per player, as opposed to the 15 sometimes used in Europe. Hoyle Classic Board 
Games uses the Chinese variation, which is the form also used in the United States.

See also
How to play Chinese Checkers
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



How to play
Chinese Checkers

The goal in Chinese Checkers is to be the first to move all of your marbles into the point (triangular area) opposite 
your home base. Two, three, four, or six people can play, but never five (because one player wouldn't have an 
opponent opposite him or her). Two people set up exactly opposite each other. Three people alternate every other 
point. (With three people, you aim not for the point directly opposite but for the home base of the opponent on your
right.) Four people set up opposite again.

Each player starts with a set of 10 marbles set up in the 10 holes or indentations of his home base. Play passes 
clockwise around the board. You can move one marble on your turn. You can move to any adjacent hole, forward, 
backward, diagonally, or sideways. If the square next to your marble is occupied by your enemy or by one of your 
own pieces, but the square on the other side is vacant, you can jump to that vacant square. A marble can make 
multiple jumps in the same turn.

See also
Getting started
How the game of Chinese Checkers evolved
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Getting started
Chinese Checkers

Before you begin the game, you may want to check the game setup to make sure all the game options are set to 
your liking. In the Game Setup dialog box for Chinese Checkers, you have the option of setting the number of 
players and whether home bases are indicated. Choose Game Setup from the Options menu to set these options.
Click a marble and drag it to an adjacent hole. You can also jump over one of your own marbles to get started.
To jump multiple marbles, click the marble, then drag it to its final destination.

See also
Shortcut keys
How the game of Chinese Checkers evolved
How to play Chinese Checkers
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Setting game rules and options
Chinese Checkers

Backgammon has different game setup options, such as setting the number of players and whether home bases 
are indicated. You control Chinese Checkers setup options using the Game Setup tab in the Options dialog box.

To set game rules and options
1 In the game you want to setup, choose Game Setup from the Options menu.
2 Make the changes you want to settings.
3 Click OK to accept the setup.

See also
How the game of Chinese Checkers evolved
How to play Chinese Checkers
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Viewing player statistics
Chinese Checkers

You display player statistics during play by choosing Statistics from the Game menu. Click the player name, then 
click the Chinese Checkers tab. The Statistics dialog box includes information on the number of games played, 
and the place standings for 2-, 3-, .4-, and 6-player games.

See also
How the game of Chinese Checkers evolved
How to play Chinese Checkers
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing the current standings



Viewing the current standings
Chinese Checkers

You display the standings for the current game during play by choosing Current Standings from the Game menu. 
The Current Standings dialog box includes information on the place standings for each player in the current game,
along with the number of jumps played. (Players must finish the game to appear in the standings.)

See also
How the game of Chinese Checkers evolved
How to play Chinese Checkers
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
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How the game evolved
Dominoes

The typical board game is played on a specially arranged surface using pieces with specific powers. The board 
doesn't have to be a portable surface of wood, metal, fabric, or plastic; it can be drawn or inscribed in the ground, 
or, as in the case of Dominoes, the "board" can be built as the pieces are laid out. Dominoes would appear to be a
typical board game -- and yet, if you want to learn this game's history, you'll have to start with playing cards.
Let's start with the principles behind all card games. There are really only three: the higher cards takes the lower 
card (Spades and Bridge, for example), similar cards make combinations (Poker and Gin Rummy), and some 
combination of the two (Pinochle).

The Chinese have it both ways
The principle of combining cards by suit or rank is probably the oldest of the three. The evidence? The Chinese 
version of Dominoes. "Dice is one of the oldest games of chance, and Dominoes are only a different arrangement 
of the dice markings," writes Catherine Perry Hargrave in The Fireside Book of Cards. In the 1920s Hargrave 
researched not only the history of playing cards but also how cards fit into and reflected their societies. "Both 
games very probably originated in China, and the Chinese seem to have been playing the domino game, either 
with tablets made of ivory or bone or with slips made of parchment or early paper, at the time when paper money 
was also being used to play a card game." 
The Chinese invented printing and paper money in the years 600 to 900. People began playing with the money 
almost immediately (as well as spending it!). Playing cards most likely evolved from this money, and one kind of 
playing card became the equivalent of our Dominoes.
Chinese Domino cards included a set of 21 cards with markings of red and black dots (corresponding to the pips 
on our Dominoes bones). There were also as many as four extra suits with fanciful decorations instead of dots. 
These decorations included chrysanthemum blossoms, bamboo, butterflies, bats, crabs, coins, scrolls, mythical 
figures -- you get the idea.
"There is a theory," Hargrave speculates, "that these domino cards also found their way into Europe in the 13th 
century, and that [the mythical figures] became the stranger persons on the 21 high cards of the Tarot series." We 
note this theory here only because of the sense of wonder it imparts. Dominoes were not reliably reported in 
Europe before the 18th century (see below), by which time the Tarot was well-established.
Whatever may have become of these figures, there seems to be a clear connection between Dominoes and 
playing cards. Merilyn Simonds Mohr makes the case in The Games Treasury, pointing out the playing-card terms 
in Dominoes. We shuffle the bones before each game, draw bones to form a hand, and dig in the boneyard when 
we can't play (which Mohr calls the equivalent of the expression Go fish). The 28 bones make up a deck and the 
deck can be broken into suits (one suit is all the bones with one blank half, a second is all the bones with one pip 
on one half, etc.).

Dominoes takes its time leaving China
Though dice spread relatively quickly around the globe, Dominoes was a sluggard. Chess, Checkers, and 
Backgammon were firmly entrenched in Europe before the first mention of Dominoes appears (in Italy in the early 
1700s). It was mostly likely brought to Italy by merchant traders, though that still doesn't explain the tardiness of 
the game's arrival. Dominoes spread to France and then to France's colony in Canada. When the British defeated 
the French in the Seven Years War (1756-63) and took control of Canada, French POWs brought Dominoes to 
England, where they found an enthusiastic following.
Joseph Strutt, an Englishman who compiled one of the first serious studies of games in English (Sports and 
Pastimes, 1801), thought Dominoes "a very childish sport." Dominoes, Strutt huffed, "could have nothing but the 
novelty to recommend it to the notice of grown persons in this country." Strutt was a better researcher than a judge
of public taste, and Dominoes has been one of the world's more popular pastimes ever since.

See also
How to play Dominoes
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
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How to play
Dominoes

Hoyle includes three versions of Dominoes (Draw, Block, and Sebastopol). These are the general rules (specific 
rules for each version follow):
Dominoes are rectangular tiles marked with every combination of numbers (21 of them) that can be rolled with two
dice. The tiles are called bones. In addition, six bones are blank on one half and one bone is blank on both 
halves, making 28 bones in a set or deck. The "heaviest" bone is marked with six dots or pips on each end: 6-6. 
(When comparing bones, one is heavier than the other if it has more dots; the other is lighter.) 
Bones whose ends are alike (as with 6-6) are called doublets. Each doublet belongs to a single suit.
To begin a game (no matter which version), the bones are placed face-down on the table and shuffled (moved 
around at random). Each player draws a certain number of bones at random to form his or her hand. For the first 
play, a bone is laid face-up on the table. The next bone laid down must match the first in some way. For example, 
if the first bone played is the 6-5, the next one down must have a 6 or a 5. You set the new bone down with 
matching ends touching.
One object of a Dominoes game is to get rid of all the bones in your hand. There may also be scoring involved in 
the course of play. Dominoes variations fall into two categories, according to what you must do when you have no 
playable move. In the block category, a player with no playable move loses a turn. In the draw category, the 
player draws more bones from the common pile (the boneyard) until finding one that can be played. If no such 
bone turns up, the player loses a turn. The lightest hand wins the total number of points in all other hands.

Block
This is the simplest variation. If two people are playing, they each draw seven bones for a hand. If three or four are
playing, they each draw five. (This distribution of bones is the same for Block and Draw; Sebastopol has its own 
distribution, as explained below.)
The player holding the highest doublet sets it -- that is, lays it down as the first play. The turn to play then rotates 
to the left. Each play is made by adding a bone to an open, or exposed, end of the layout, with equivalent numbers
touching. The layout in Block always has two open ends. Two branches are built off the sides of the set (the 
doublet that began the game). All doublets are customarily placed crosswise, but this doesn't affect the number of 
open ends.
If a player has no legal move, he or she passes. The game ends when a player gets rid of his or her hand or when
no player is able to add to the layout. The player with the lightest remaining hand wins the total number of pips on 
all the bones remaining in the other hands. (The amount needed to win a game is usually decided among the 
players before play begins.)

Sebastopol
This sounds like a battle in the Crimean War, but so far as is known the Charge of the Light Brigade has nothing to
do with it. There's no boneyard. Four people play, each drawing seven bones. The 6-6 is set, after which play 
rotates to the left of the first player. The 6-6 is open four ways, and the first four plays after the set must fill each 
opening -- no branch may be extended before these four bones are laid down (unless the Allow Sprout Rule option
is used). All other Block rules apply.
The Allow Sprout Rule means that branches can be extended before the first four plays after the set. If this option 
is unchecked, the first four branches must be set before any branches can be extended.

Draw
If you've mastered Block, then you have only one thing to remember about Draw: a player having no playable 
bone must draw from the boneyard until a playable bone turns up. Once the boneyard is empty, a player with an 
unplayable hand must pass.

Here are the shortcut keys available for Dominoes:

Actions Shortcut key
Pass Enter

See also
Shortcut keys
Getting started
How the game of Dominoes evolved
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Changing the current human player
Changing the look of the background
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Setting game speed
Setting player attitude
Viewing player statistics
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Getting started
Dominoes

Before you begin the game, you may want to check the game setup to make sure all the game options are set to 
your liking. In the Game Setup dialog box for Dominoes, you have the option of setting:

the number of players.
the number of bones each player must hold in their hand to start.
the score required for a player to win.
whether play must start with the highest double played to the table.
whether the last two bones must be left in the boneyard.
whether players have the option to pass.
which variation of play is used (Block, Draw, or Sebastopol).

Choose Game Setup from the Options menu to set these options.
When you are ready to start play, click each bone you want to select for your pile. Click and drag the bones to the 
position you want to play them.
If you don't have any possible moves, go back to the boneyard (main pile) and click bones until you get one you 
can play. If you don't have any moves and all the bones are out of the boneyard, you may need to choose Pass.

Here are the shortcut keys available for Dominoes:

Actions Shortcut key
Pass Enter

See also
Shortcut keys
How the game of Dominoes evolved
How to play Dominoes
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Setting game rules and options
Dominoes

Dominoes has different game setup options, such as setting:
the number of players.
the number of bones each player must hold in their hand to start.
the score required for a player to win.
whether play must start with the highest double played to the table.
whether the last two bones must be left in the boneyard.
whether players have the option to pass.
which variation of play is used (Block, Draw, or Sebastopol).

You control Dominoes setup options using the Game Setup tab in the Options dialog box.

To set game rules and options
1 In the game you want to setup, choose Game Setup from the Options menu.
2 Make the changes you want to settings.
3 Click OK to accept the setup.

See also
How the game of Dominoes evolved
How to play Dominoes
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Viewing player statistics
Dominoes

You display player statistics during play by choosing Statistics from the Game menu. Click the player name, then 
click the Dominoes tab. The Statistics dialog box includes information on the number of games played, won, and 
tied.

See also
How the game of Dominoes evolved
How to play Dominoes
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing the current standings



Viewing the current standings
Dominoes

You display the standings for the current game during play by choosing Current Standings from the Game menu. 
The Current Standings dialog box includes information on the number of hands won in the current game, the pip 
count (the number of points from opponents unplayed bones), and the total score for the game.

See also
How the game of Dominoes evolved
How to play Dominoes
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
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How the game evolved
Pachisi

Racing games have been developed by almost every culture on Earth. When the Conquistadors landed in Central 
America, they were surprised to find the Indians playing a game on a cruciform (cross-shaped) track with some 
resemblance to Pachisi.
Pachisi is a Hindu word meaning "25," a reference to the method of scoring used in the original game. It's an old 
game, perhaps dating from the era in which the Indians (of India) invented Chess (6th century AD). It's still popular
in India.
The Pachisi we're familiar with in America was patented by an Englishman in 1896. He called it Ludo, but in this 
country we call it by its ancient name (though we use the Ludo rules). The modern board is square, but the track 
on which the pieces race is still cross-shaped.
Americans also know this game as Parcheesi(tm) (introduced in Britain in 1874), Sorry!(tm), which uses cards and
a square track instead of dice and a cross-shaped track, and Trouble(tm), which uses dice in a plastic bubble in 
the center of the board. You push on the bubble to "throw" the dice. The track is a square.
It's worth mentioning two aspects of Pachisi (besides its name) that help to identify its origins:
First, the pieces move counter-clockwise; this is generally thought to be characteristic of Asian games. In most 
Western games, the pieces move clockwise.
Second, certain squares on the Pachisi board act as "castles" in which the pieces of one player (or one team) may
take refuge and not have to worry about being bumped back to the beginning of the course. In some early forms of
Chess, particularly as that game spread eastward toward China, each side could send at least a few pieces to 
safety inside a castle or citadel.

See also
How to play Pachisi
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



How to play
Pachisi

Players move their pieces (one at a time) out of their base (or field or starting square), take one trip around the 
track, and head up the middle toward home. A piece can't leave its base until the player has thrown a five (5); 
either on a single die, or as combination of both die.
You can be bumped back to your base if you're not standing on a safe square when an enemy piece lands on you.
The first player to bring all four of his pieces home is the winner.
When you roll the starting number (a "5"), move your piece to the black square with the dot in your color. After the 
piece is on this space, you can then use other rolls to move it. If you don't want to use one of the die rolls, choose 
Pass.
You can't bump a piece that occupies a safe square (black space with white dot).
Two pieces on the same space form a blockade. No pieces can move past the blockade (not even pieces of the 
same color). You cannot use a doubles roll to advance a blockade to a new space. No more than two pieces can 
occupy a space at the same time.
When you get a piece home, you get a 10 space bonus, which means you can move any combination of your 
pieces 10 spaces. When you bump someone, you get a 20 space bonus, which means you can move one of your 
pieces 20 spaces. If you can't use your bonus spaces on the turn, you lose them (they don't accumulate).
When you get near home, use the middle row of squares (the "home stretch") to go to the final home square. You 
must roll the exact number needed to get to the home square.

Tip You have the option of bypassing your home stretch and making an additional circuit around the board. You 
might want to use this tactic to bump the piece of another player who might be in the lead or on the verge of 
winning.

Here are the shortcut keys available for Pachisi:

Actions Shortcut key
Pass Enter
Roll Dice Spacebar

See also
Shortcut keys
Getting started
How the game of Pachisi evolved
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Getting started
Pachisi

Before you begin the game, you may want to check the game setup to make sure all the game options are set to 
your liking. In the Game Setup dialog box for Pachisi, you have the option of setting the number of players and 
whether rolling three doubles in a row sends a piece directly to home. Choose Game Setup from the Options 
menu to set these options.
When you are ready to start play, click your starting area to roll the dice. Each player must roll a five (5) with one or
both die to leave home base and go to the starting square of his or her color. Until you roll a five with one or both 
die, you cannot move out of the starting area.
Move your pieces in a counter clockwise direction. Safe squares are the black spaces with a white dot. (A piece 
cannot be bumped from a safe square.) Players start squares (colored dot on a black space) are not safe. You can
bump an opponent's piece, or an opponent can bump your piece when the piece is on a start square.
Move two pieces to a space to create a blockade. (No pieces can move past a blockade). No more than two 
pieces can occupy a space at the same time.

Here are the shortcut keys available for Pachisi:

Actions Shortcut key
Pass Enter
Roll Dice Spacebar

See also
Shortcut keys
How the game of Pachisi evolved
How to play Pachisi
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Setting game rules and options
Pachisi

Pachisi has different game setup options, such as setting the number of players and whether rolling three doubles 
in a row sends the piece closes to Home back to the Start. You control Pachisi setup options using the Game 
Setup tab in the Options dialog box.

To set game rules and options
1 In the game you want to setup, choose Game Setup from the Options menu.
2 Make the changes you want to settings.
3 Click OK to accept the setup.

See also
How the game of Pachisi evolved
How to play Pachisi
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Viewing player statistics
Pachisi

You display player statistics during play by choosing Statistics from the Game menu. Click the player name, then 
click the Pachisi tab. The Statistics dialog box includes information on the number of games played and won.

See also
How the game of Pachisi evolved
How to play Pachisi
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing the current standings



Viewing the current standings
Pachisi

You display the standings for the current game during play by choosing Current Standings from the Game menu. 
The Current Standings dialog box includes information on each player's place standings (1st, 2nd, 3rd, 4th) and 
the number of spaces each has left to make it home.

See also
How the game of Pachisi evolved
How to play Pachisi
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
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How the game evolved
Snakes & Ladders

Though Snakes & Ladders is popular primarily with children, adults should not dismiss it as superficial, as it 
belongs to a gaming tradition -- racing -- that stretches back 6,000 years. Not bad for a kids' game!
The Egyptians of 4,000 BC left behind fragments of game boards that researchers surmise were tracks for little 
wood runners to race on. By 2,500 BC the Egyptians were painting (in their curious, two-dimensional style) on the 
walls of their tombs representations of people thinking hard over game boards. With some paintings, we can't 
really know what's going on; since the Egyptians painted in profile, it's impossible to know what the boards looked 
like or what the pieces were doing on them. With other paintings, however, the profile view is not a problem. The 
pieces on the boards are engaged in a race.
Many boards and pieces have been recovered from this period, not only in Egypt but in the early civilizations of Ur,
Palestine, and Assyria as well. These too are racing games, in particular an Egyptian game that archaeologists call
"Dogs & Jackals" (after the carved heads of the pieces). "Boards" for racing games have also been found chiseled 
into the floors of buildings, courtyards, and public areas in ancient, long-abandoned towns in Egypt, India, Persia, 
China, Italy, and Spain.

The English stake their claim....
Snakes & Ladders evolved in England from earlier racing games, though we don't know for certain which ones. A 
likely candidate is Goose, a racing game of Italian origin that entered England shortly before 1600. Whereas 
Snakes & Ladders has a single reward, the ladder, and a single penalty, the snake, Goose has one reward 
(landing on a goose gives you another turn) and many penalties (including going to prison, getting lost in a maze, 
and falling down a well).
Goose was exceedingly popular among adults at this time, when Shakespeare was still alive and the civil war that 
would temporarily throw out the English monarchy was still decades away. Perhaps Snakes & Ladders was 
intended to be the Goose for children.

....and so do the Hindus
Merilyn Simonds Mohr, in The Games Treasury, has a different idea. She cites an old game from India, "Moksha-
Patamu" ("Heaven and Hell"), as the source for our Snakes & Ladders. Hindus used Moksha-Patamu to teach 
their children how to survive in a world of good and evil. In the Indian game, each ladder rose from a "square of 
virtue" (Faith, Reliability, Generosity) while each snake descended from squares of "wickedness" (Disobedience, 
Theft, Drunkenness).
Mohr has uncovered a game patented in England in 1892 as Snakes & Ladders; this is surely not the first 
appearance of this game, but perhaps a reformatting of Snakes & Ladders along the Hindu lines. Mohr notes that 
"while vices outnumbered virtues in the Indian game, most early Snakes & Ladders variations balance the two, 
and more recent versions give the players more ladders to climb than snakes to slither down. Today's games are 
stripped of moral overtones; in some versions, even the snakes have been replaced by 'chutes.' "
With the Hindus, you hit the snake's head and slide down to its tail. In North America, the snakes have no 
significance and are often reversed.

See also
How to play Snakes & Ladders
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



How to play
Snakes & Ladders

You start at the bottom of the hill and move upward according to the roll of the dice. If you land on a square that's 
supporting a ladder (red squares), your piece climbs that ladder to the square at the top. But if you land on a 
square at the top of a snake (blue squares), you slide down that snake to the square at the bottom. The first player
to the summit wins.

Here are the shortcut keys available for Snakes & Ladders:

Actions Shortcut key
Draw Ball Spacebar

See also
Shortcut keys
Getting started
How the game of Snakes & Ladders evolved
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Getting started
Snakes & Ladders

Before you begin the game, you may want to check the game setup to make sure the game options are set to your
liking. In the Game Setup dialog box for Snakes & Ladders, you have the option of setting the number of players. 
Choose Game Setup from the Options menu to set these options.
When you are ready to start play, click on the flashing circle by your player image, or choose Draw Ball, or click the
wheel crank (lower right on screen), or press the Spacebar.
The ball rolls to your area to indicate your roll. Your player automatically moves the number of spaces that you 
rolled.

Here are the shortcut keys available for Snakes & Ladders:

Actions Shortcut key
Draw Ball Spacebar

See also
Shortcut keys
How the game of Snakes & Ladders evolved
How to play Snakes & Ladders
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Setting game rules and options
Snakes & Ladders

Snakes & Ladders has game setup options for choosing the number of players in a game. You control Snakes & 
Ladders setup options using the Game Setup tab in the Options dialog box.

To set game rules and options
1 In the game you want to setup, choose Game Setup from the Options menu.
2 Make the changes you want to settings.
3 Click OK to accept the setup.

See also
How the game of Snakes & Ladders evolved
How to play Snakes & Ladders
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Viewing player statistics
Snakes & Ladders

You display player statistics during play by choosing Statistics from the Game menu. Click the player name, then 
click the Snakes & Ladders tab. The Statistics dialog box includes information on the number of games played and
the place standings totals.

See also
How the game of Snakes & Ladders evolved
How to play Snakes & Ladders
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing the current standings



Viewing the current standings
Snakes & Ladders

You display the standings for the current game during play by choosing Current Standings from the Game menu. 
The Current Standings dialog box includes information on the current place standings.

See also
How the game of Snakes & Ladders evolved
How to play Snakes & Ladders
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
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How the game evolved
Yacht

Most Americans know this game from the popular commercial variant, Yahtzee(tm). Supposedly, the marketer of 
this game bought it from Canadians who called it Yacht because that's where they played it. (However, according 
to the current edition of Hoyle's Rules of Games, Yacht is usually played "in a restaurant or bar to decide who pays
the check.")
Yacht by any name was originally a means of playing Poker with dice instead of cards (hence another of its 
names, Poker Dice). Special Yacht dice are made with an ace, king, queen, jack, 10, and 9 replacing the pips of 
the standard dice. Today, most people play Yacht with standard dice and without much thought for its Poker 
origins, even though most of the game's terminology comes from Poker.

See also
How to play Yacht
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



How to play
Yacht

Yacht uses five dice. Any number of people can play (though with just one person the only goal is to beat your past
high score). The object is to make the best possible hand in the following categories:
Hand Score
Ones Total of ones
Twos Total of twos
Threes Total of threes
Fours Total of fours
Fives Total of fives
Sixes Total of sixes
Four of a Kind Dice total
Full House Dice total
Four Straight 25
Five Straight 30
Yacht (Five of a Kind) 50
Choice Dice total

There are 12 categories and you have 12 turns. On each turn you roll the dice three times. You can keep one or 
more die from each roll to build your hand; you can also discard the die or dice you kept from the first roll if the 
second roll changes your mind. You can stand pat after the first or second rolls if your hand is good enough.
Tip To move dice from the board into your "keeper" area without clicking each die, type the number of each die's 
value on the keyboard. For example, if you roll two 4s that you want to keep, press 4 on the keyboard, then press 
4 again (to pick up the second 4). To move dice from the "keeper" area back to the play area, press Backspace.
Your goal is to fill in each category in the chart above with the highest possible number. A 4-4-5-5-5 Full House, for
example, is 23 points. Once you fill a category, you go on to another. If you throw a second Full House, say a 4-4-
4-3-3, you may choose the Fours category. Your score then would be 12 (the threes in this example wouldn't 
count).
(With Four of a Kind, the number on the fifth die does count in the scoring. Example: 6-6-6-6-1 is Four of a Kind, 
but it counts as 25.)
Three categories already have scores: Four Straight (25), Five Straight (30), and Yacht (50). These numbers are 
higher than the highest possible totals on your dice for those particular hands, so consider these scores a bonus.
The Choice category is just that -- your choice. Use this category if your hand has a high point value but doesn't fit 
anywhere else. You'll receive the total points showing on your dice.
If your hand isn't much of anything, choose the lowest possible category to minimize the damage. For example, if 
you're left with low, miscellaneous numbers, choose Ones even if have none. You'll receive a zero for that 
category, but since the category is devoted to the lowly numeral one, how many points could you get there 
anyway?
At the end of 12 rounds all of the categories will be filled in and the game ends. High score wins.

Here are the shortcut keys available for Yacht:

Actions Shortcut key
Roll Dice Spacebar
Keep Dice <Type each die number>
Release Dice Backspace

See also
Shortcut keys
Getting started
How the game of Yacht evolved
Adding or removing players
Changing a character player



Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Getting started
Yacht

Before you begin the game, you may want to check the game setup to make sure the game options are set to your
liking. In the Game Setup dialog box for Yacht, you have the option of setting the number of players. Choose 
Game Setup from the Options menu to set these options.
When you are ready to start play, click on your cup to roll. Click each die that you want to keep, then click the cup 
to roll again. If you want to re-roll a die that you previously chose to keep, you can return it to the board by clicking 
it. When you are ready to roll again, click the cup. You have the option to roll up to three times, but you can choose
to record your score on any roll.
Tip To move dice from the board into your "keeper" area without clicking each die, type the number of each die's 
value on the keyboard. For example, if you roll two 4s that you want to keep, press 4 on the keyboard, then press 
4 again (to pick up the second 4). To move dice from the "keeper" area back to the play area, press Backspace.
To record your score category, click on an appropriate category on the score card. As you move your mouse 
cursor over each category, you can preview the resulting score for the current roll. Be sure to select the category 
carefully; once you choose it, you can't change it later. After the score is recorded, the turn advances to the next 
player.

Here are the shortcut keys available for Yacht:

Actions Shortcut key
Roll Dice Spacebar
Keep Dice <Type each die number>
Release Dice Backspace

See also
Shortcut keys
How the game of Yacht evolved
How to play Yacht
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Setting game rules and options
Yacht

Yacht has game setup options for choosing the number of players in a game (1, 2, 3, or 4). You control Yacht 
setup options using the Game Setup tab in the Options dialog box.

To set game rules and options
1 In the game you want to setup, choose Game Setup from the Options menu.
2 Make the changes you want to settings.
3 Click OK to accept the setup.

See also
How the game of Yacht evolved
How to play Yacht
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Viewing player statistics
Yacht

You display player statistics during play by choosing Statistics from the Game menu. Click the player name, then 
click the Yacht tab. The Statistics dialog box includes information on the total number of games played, the 
number of competitive games played, won and tied, the average score, the high score, and the low score.

See also
How the game of Yacht evolved
How to play Yacht
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing the current standings



Viewing the current standings
Yacht

The score for all Yacht players is always displayed in score cards on the Yacht game screen (so the Current 
Standings menu command is not needed).
To peek at another player's score card when it isn't that players turn, click on the player's score display (located 
near the top of the player's name plaque) and hold down the left mouse button. The player's score pad appears as
long as you hold the mouse button down.

See also
How the game of Yacht evolved
How to play Yacht
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
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How the game evolved
Zen Bones

Zen Bones a simplification of Mah Jongg, which itself is an American simplification of a Chinese game of the 19th 
century. (The Chinese original was played by different rules and known by different names throughout that country;
one name that's come down to us translates roughly as "Game of the Four Winds.")
An American businessman named Joseph Babcock, who was living in Shanghai at the close of World War I, 
played the Chinese game and fell in love with it. He thought it would appeal to Americans, so he set about 
codifying (and streamlining) the rules. Babcock coined the name Mah Jongg for the new version; supposedly, he 
took this name from the bird that appears on one of the game's tiles. The bird represents a mythical figure called 
by the Chinese (this is an approximation) Mah Jongg, "Bird of a Thousand Intelligences."
Babcock might not have been as smart as that bird, but his hunch about the gaming marketplace was sound. Mah 
Jongg became a thunderous hit in the United States, Great Britain, and Australia in the 1920s. The game is still 
played today, though it no longer commands an army of fanatics as it did 70 years ago.
Mah Jongg is superficially similar to Dominoes in that both games use tiles, or bones, and because the 
arrangement of the tiles forms the board. Zen Bones shares that similarity with Dominoes; it also resembles 
certain card games, such as Gin Rummy, where making matches is the order of the day.

See also
How to play Zen Bones
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



How to play
Zen Bones

At the start of the game, the tiles or bones are randomly arranged in the layout shape that you select. Your job is to
match tiles in pairs. Each pair, once found, are removed from the layout. You keep matching pairs until there are 
no more in the layout, trying to end with the fewest tiles remaining. You can then stop and begin with a new layout,
or reshuffle the remaining tiles and continue on.
There are seven categories, or suits, of tiles:

Circles (from one to nine)
Characters (Chinese letters)
Flowers (Mum, Plum, Bamboo, Orchid)
Seasons (Winter, Spring, Summer, Autumn)
Compass Directions (North, South, East, West)
Bamboo (not to be confused with the "bamboo" tile of Flowers)
Dragons (including one that looks as if a sword has been thrust through it)

Many of the tiles are numbered, but these numbers are for your convenience in making matches -- they don't 
figure in the scoring (since there is no scoring). You can't match across suits; two tiles with nine circles are a 
match, but a Nine of Circles and a Nine of Bamboo don't work.
Any of the Flowers can be matched, for example, Mums with Plums. Any Season matches any other Season, for 
example, Winter with Spring. The Compass Directions can only be matched against the exact same direction, as 
with North and North or South and South. (This is also true for the three kinds of dragons.)
The Bird of a Thousand Intelligences is considered part of the Bamboo suit, but this distinction is only of 
consequence in Mah Jongg, where suits count in the scoring.

Here are the shortcut keys available for Zen Bones:

Actions Shortcut key
Find Match M
Remove Pair Enter
Undo Ctrl+Z

See also
Shortcut keys
Getting started
How the game of Zen Bones evolved
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Getting started
Zen Bones

When the game first opens, choose a layout from the available bone layouts in the Select Layout dialog box.
Before you begin the game, you may want to check the game setup to make sure all the game options are set to 
your liking. In the Game Setup dialog box for Zen Bones, you have the option of setting the number of players (1 
for Solitaire, 2 for Challenge), the bone layout, whether a timer is used during play, and whether tiles are placed 
faced down. Choose Game Setup from the Options menu to set these options.
Click a tile, then click its match. That's all there is to it!
When you find all possible matches, a dialog box appears with the following options:

Same Layout, shuffle tiles
Same Layout, don't shuffle tiles
Shuffle Remaining Tiles
New Layout
Undo Last Move

Here are the shortcut keys available for Zen Bones:

Actions Shortcut key
Find Match M
Remove Pair Enter
Undo Ctrl+Z

See also
Shortcut keys
How the game of Zen Bones evolved
How to play Zen Bones
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Setting game rules and options
Zen Bones

Zen Bones has different game setup options, such as setting the number of players (1 for Solitaire, 2 for 
Challenge), the bone layout, whether a timer is used during play, and whether tiles are placed faced down. You 
control the game setup using the Game Setup tab in the Options dialog box.

To set game rules and options
1 In the game you want to setup, choose Game Setup from the Options menu.
2 Make the changes you want to settings.
3 Click OK to accept the setup.

See also
How the game of Zen Bones evolved
How to play Zen Bones
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game speed
Setting player attitude
Viewing player statistics
Viewing the current standings



Viewing player statistics
Zen Bones

You display player statistics during play by choosing Statistics from the Game menu. Click the player name, then 
click the Zen Bones tab. The Statistics dialog box includes information on the number of Solitaire games played 
and won, the average number of matches found, and the current streak of wins or losses. The statistics also 
include the number of Challenge games played, won, and tied.

See also
How the game of Zen Bones evolved
How to play Zen Bones
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
Controlling sound effects, animations, or background music
Setting game rules and options
Setting game speed
Setting player attitude
Viewing the current standings



Viewing the current standings
Zen Bones

You display the standings for the current game during play by choosing Current Standings from the Game menu. 
The Current Standings dialog box includes information on the number of matches found, the number of matches 
left, and the total time spent.

See also
How the game of Zen Bones evolved
How to play Zen Bones
Getting started
Adding or removing players
Changing a character player
Changing the current human player
Changing the look of the background
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Setting game speed
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